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1. CAUTIONARY WARNING AND WARRANTY

1.1 CAUTIONARY WARNING

The logic analyzer functions of the Omni Series are designed for

use only by qualified technical personnel trained to work on electronic

circuitry that is in a power-on condition. Such circuitry may have

hazardous voltages present; the operator must have a knowledge of

electronic circuit operation, accepted maintenance procedures, and

appropriate safety practices for the circuitry being tested.

1.2 LIMITED WARRANTY

OmniLogic, Inc., warrants each new system against defects in

material or workmanship for a period of ninety days from date of

delivery to the original customer. The Logic Analyzer Printed Circuit

Board has a warranty period of one year. Fuses, probes, and probe tips
are excluded from this warranty. This warranty is specifically limited

to the replacement or repair of any defects, without charge, when work

is authorized or unit is returned to OmniLogic, Inc., 350 Sunset Blvd

N., Renton, WA 98055, transportation charges prepaid. This express

warranty excludes all other warranties, expressed or implied, and IN NO

CASE SHALL THE LIABILITY OF OMNILOGIC, INC., EXCEED THE PURCHASE PRICE

OF THE UNIT. OMNILOGIC, INC., SHALL NOT BE MADE LIABLE FOR INCIDENTAL

OR CONSEQUENTIAL DAMAGES. No liability is assumed for damage due to

accident, abuse, lack of reasonable care, less of parts, unauthorized

service, or subjecting the instrument to faulty peripherals or input
Values exceeding specified limits.

Omni Operating Manual 1-1 Cautionary Warning
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2. INTRODUCTION

This manual describes the operation of OmniLogic, Inc.'s Logic

Analyzers. The purpose of the manual is to enable you to use the Omni

analyzer to make digital measurements most effectively. The Omni is

designed for maximum user convenience so that your attention will be on

the circuit you are testing, rather than on the instrument itself.

Menus and on—line Help Page explanations make the Omni extremely

easy to use. Every screen display includes a prompt line at the bottom

which gives you the allowable commands. A label on the keyboard also

lists the most often used commands. Little training or reference to

other materials are needed to use the instrument effectively. Most of

the material in this manual, in fact, is on-line and available to you

with a few keystrokes; the Omni, itself, will teach you most of what you

need to know in order to use it.

This manual covers only the Logic Analyzer functions. Use of the

Omni as a CP/M computer is described in the computer manuals packed with

the unit.

This manual has a section devoted to each command, and covers the

operation of the Omni analyzer in detail. The last section, "Quick

Start", leads you through the functions and commands, beginning with

turn—on. If you have never used the Omni before, we suggest you start

with the Quick Start section (Appendix A) and go step-by—step through
the Omni's functions. Due to software improvements, there may be slight
differences between photos in this manual, the descriptions, and your

unit.

The information in the Help Pages in your Omni may vary slightly
from that given here; if so, check the revision date to make sure that

you have the latest version.

Omni Operating Manual 2-1 I: ,13, stun





3. OMNI SPECIFICATIONS*

3.1 LOGIC ANALYZER DATA COLLECTION CHARACTERISTICS

Sample Rates

Internal Clock

Available periods

External Clock

Minimum period
Maximum period
Clock stable prior

to active edge

Clock Qualify
Setup
Hold

Number of samples collected

Trigger point

Delay between event trigger
to data collection

Data Channels F through 0

Data stable prior to

active edge of clock

Data stable after

active edge of clock

Glitch Channels 3 through 0

Glitch definition

Minimum detectable pulse

3.2 TRIGGER CONDITIONS

Data functions

Glitch functions

50, 100, 200, 500ns

1, ... 32768us

SOns

unlimited

35ns

30ns

Ons

1000

16th, 32nd, ...

992nd sample

0 to 34 seconds

35ns

Ons

2 or more data

transitions in

1 sample period

lOns

AND/OR/NOT on data

AND/OR/NOT with data

*Specifications are suhiect to change without notice.
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Latched (synchronous) mode

Setup
Hold

Unlatched (asynchronous) mode

Minimum event duration

External Trigger duration

External Trigger Qualify
Minimum active

during event

Active after

Timeout mode

Duration between events

Repeat until reference

memory correlated

or not correlated

3.3 DISPLAY MODES

Waveform format

Sample window

Number of channels

Edge format

Sample window

Number of channels

Dump format

Sample window

Number of channels

Matrix format

Sample window

Number of channels

Display matrix

Instruction Disassembly
format

Sample window

Number of channels

Processors supported

30ns

Ons

15ns

25ns

25ns

Ons

16us to 345ec

80 to 1000 samples, scrollable

1 to 16 channels

80 to 1000 samples, scrollable

1 to 16 channels

252 binary, 231 octal

232 unsigned decimal

232 signed decimal

336 hexadecimal

all scrollable

1 to 16

1 to 1000 samples
2 to 8

‘

16 rows X 16 columns

13 scrollable

4, 8, or 16

2—80, 8085, 8048

family and

user-definable

Specifications are suhiect to change without notice.
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Signature format

Sample window

Number of channels

3.4 UTILITY CAPABILITIES

Pattern Search

Interval Calculation

Correlation

Channel Labels

Printer Output

File Operations

Help Pages

Extensive built-in tests

3.5 PROBE CHARACTERISTICS

Left Pod

Clock

D0

D1

D2

D3

D4

D5

D6

D7

Trigger
GroundFOWWNO‘WJ-‘UNH,_.._.

1000 samples
14 simultaneous

1 to 16 bit maskable

1 to 6 sample sequence

Time and sample number

between cursor

and/or 2 events

1 to 1000 samples
1 to 1000 start skew

l to 16 channel tolerance

1 to 1000 sample
error allowance

1 to 15 characters

per channel

Any display on CRT

and multiple
sequential displays

Save and recover set-up
and/or data

Built-in explanations
and examples at all

steps of operation

Suggested
Right 329 Lead Color

Clock Qualifier Yellow/White
D8 Black

D9 Brown

D10 Red

D11 Orange
D12 Yellow

D13 Green

D14 Blue

D15 Violet

Trigger Qualifier Red/White
Ground Green/White

Specifications are subject £2 change without notice.
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Minimum detectable pulse 10 nanoseconds

Maximum voltage limits -O.5V, +5.5V

Input impedance 1 megohm

Logic level transition to

low level

TTL probes 0.8V

CMOS probes 1.0V

Logic level transition to

high level

TTL probes 2.0V

CMOS probes 3.5V

Specifications are subject 3; change without notice.
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C? /M COMPUTER*

CPU Z—80A System

Rm! 64K Bytes

Mass storage Omni II - 380 Kbytes via dual 5-1/4
inch, single sided, double

density floppy disk drives

Omni 4 - 780 Kbytes via dual 5-1/4
inch, double sided, double

density floppy disk drives

Omni 2020 - 730 Kbytes via dual 5-1/4
inch, double sided, double

density floppy disk drives

Disks recommended Omni [I - single sided 5-1/4 inch

floppy disks (Maxell MDl—D)
Omni 4 and 2020 — double sided

5—1/4 inch floppy disks (Maxell
MDZ—D)

Keyboard Full ASCII keyboard with numeric pad
and cursor control keys,
detachable. Keys are

programmable.

Display 9 inch, 24 row x 80 column

8 x 11 pixel character
Omni II and 4 -

green phosphor
Omni 2020 - ergonomic yellow

phosphor, nonglare surface

Graphics Omni 4 - 160 x 100 pixels
Omni 2020 - 640 x 240 pixels

I/O connections RS—ZBZC serial port
(Omni 4 has two serial ports)

"Centronics" parallel port

Modem (Omni 4 only) 300 Baud, full or half duplex, auto

dial/auto answer

Real Time Clock (Omni 4 only) Resolution to .0001 second, 5-year
lithium battery backup

*Specifications are subject to change without notice.

Rev. D
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4. UNPACKING

If there is damage to the inner carton, inspect the Omni carefully.
If the Omni is damaged, call us immediately at (206) 271-2000 for

further instructions.

Set the Omni on a firm surface. The keyboard is attached to the

main unit by clamps at the right and left sides. The keyboard cable may
be packed between the keyboard and main unit. The Omni 4 provides a

storage area for the probes below the disk drives, and the probes and

probe leads are packed there. There is also a convenient disk storage
area just below the drives-

The Omni logic analyzer disks and the CP/M Operating System Disk

are packed separately from the other disks and manuals, which are in a

single large flat package within the Logic Analyzer carton.

Remove the remaining items from the carton, along with the System
Checklist. Verify that you have received everything on the Checklist.

If there are any items missing compared to the Checklist enclosed with

the unit, please call and let us know.

Table 4-1 on the next page shows a typical checklist.

Omni Operating Manual 4-1 Unpacking



Table 4-1 TYPICAL SYSTEM CHECKLIST

NOTE: This list is provided here as an illustration only. The items

included in your system may be different. Use the correct System
Checklist enclosed with your unit to verify that your shipment is

complete.

Item No. Qty. Description
1 2 Omni Logic Analyzer Disks (master and

working copy)
2 l CP/M Operating System Disk
3 1 Software Package — package of manuals and

disks

4 1 Operating Manual (this manual)
5 1 Main Unit with Power Cord

6 1 Keyboard
7 1 Keyboard Cable

8 2 Cables and Pods

each ribbon cable is 36" long
and has a pod at one end

9 1 Package of 11 Leads with 11 Clips
6" leads, ganged together

10 1 Package of 11 Leads with 11 Clips
6" leads, separable kind

Rev. D
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5. TURN—ON PROCEDURE

5.1 INTRODUCTION

Now that you have the Omni unpacked, you can set it up and try it
out. The Omni may be used as either a 2-80 based computer with the CP/M
operating system or as a logic analyzer for probing the operation of

digital circuits.

The Omni should be used to test digital equipment only by qualified
technical personnel (see "Cautionary Warning”, Section 1).

The Omni is intended to operate from an 120 volt AC, 60 Hz power
source as marked on the rear panel. The Omni is grounded through the

grounding conductor of the power cord. To avoid electrical shock, plug
the power cord into a properly wired receptacle before connecting to the

input or output terminals. A protective ground connection by way of the

grounding conductor in the power cord is essential for safe operation.

We also recommend that you use the Omni only on a safe technician's
test bench when testing digital circuits. That means: 1) A bench or

table on which any metal parts you are likely to come in contact with
are grounded. Then if a conductor carrying high voltage comes in
contact with the bench, it will not make the bench itself "hot" and a

hazard to you. 2) A nonconductive surface should be on the floor in
front of the bench for you and your chair to stand on. Thus, if you do

inadvertently come in contact with a hazardous voltage circuit, there is
no current path through ygg to ground.

OPERATOR SAFETY COMES FIRST

If necessary, ground your bench now before proceeding further.

CAUTION

Both the Omni main unit and the probes contain circuitry that is

potentially susceptible to damage from electrostatic discharges.
Although the probes are input protected against static discharge, when

you approach the Omni it is good practice to dissipate any static

charges accumulated on your body by touching the chassis before touching
the probe pins. Likewise, much digital equipment is static sensitive.
You should touch the chassis of any equipment you are testing before

making probe connections to it or touching the internal circuitry. Take
these precautions after plugging in the power cord to establish a ground
connection.

When you are using the Omni as a CP/M computer, the probes need not
be connected and you can use it at an ordinary desk or table.

Omni Operating Manual 5‘1 Turn-on Procedure



QLg SETTING g3 Egg KEYBOARD

Place the Omni flat on your work surface. The keyboard also serves

as the front cover, and is held on by clamps on the right and left

sides. Unfasten the clamps and remove the keyboard. Connect the

telephone—type coil cord between the connector on the keyboard (on the

rear edge) and the connector on the main unit (on the rear panel, near

the top). If there are two telephone—type connectors on the main unit,
use the one labeled "KEYBOARD."

You can lift the main unit and lower the stand on the underside so

that the screen is tilted up and easily visible.

The Omni is shipped with cardboard packing cards in the floppy disk

drives to protect the read/write heads. Open the doors of both drives

and remove the cards. Save the cards for whenever you may want to ship
the unit in the future.

Disk drive doors open at turn-on and turn-off!

Turning the machine on or off with a disk in the drive and the door

closed may result in scrambling the data on the disk. Opening the drive

door moves the head away from the disk, preventing power transients from

affecting the data on the disk. It is all right to have disks in the

drives at turn-on and turn-off as long as the doors are open.

If you anticipate a possible power interruption - due to a

lightning storm or electricians working on the power mains in your

building, for example -

open the drive doors even while using the Omni,

closing them only when file reads or writes are required. (This won’t

work with a program which uses overlays, such as Wordstar, since the

program automatically performs disk accesses when you may not expect

it.)

If you do scramble the data on a diskette, then you will have to

use your backup diskette to make a new working copy. And if you don’t

have a backup...

5.3 POWER g

The power switch is the large rocker switch on the rear panel.
Turn it on now. The drives will start whirring and you will soon see:

* Omni *

Please insert your diskette into Drive A

Insert whichever diskette you are going to use in Drive A. To use

the Omni as a logic analyzer, use the Logic Analyzer Operation Disk.

It is all right to put a disk in the Omni while the drive is

whirring and the red light on the drive is on. (This is not true for all

computers). To put the disk in the right way, hold it with the label

up. Do not fold the floppy disk, touch the magnetic recording surface,
or put it near magnetic materials.

Omni Operating Manual 5—2 Turn-on Procedure



5.4 MASTER MENU

When you close the door of the drive, the computer will load the

operating system and display the Master Menu - see Exhibit 5—1. A new

feature that makes the system very easy to use, the Master Menu

automatically provides information about each menu choice.

Earlier Omni models (1984 and prior) do not have the Master Menu

feature and use the standard CP/M user interface. (The standard

interface may be reached from the Master Menu by pressing <ESC>). The
last section of this chapter, section 5.8, covers the differences of the

older units.

The Master Menu groups the files on a disk into categories.
Initially, information about the categories is displayed. When you

move the cursor-bar to a category using the cursor keys, the individual

items in that category are listed along with information about them.

When you indicate an individual item, more detailed information about it

appears.

5:37 pm 5 6 BS Nosfer Menu VET310n 5.22 / 7.7

ThlS will #abe gou is

a sub-menu Tha? mil

allow gnu to use Me

0"!” 4 as a Log»:
Fhelgzor and with

exfernal hardware as

an EPRCM Programmer
or Paffern Generafor .

#

-39 Me Lip-arrow and dean-arrow begs to move The

flag-ed bar To gour chance. Then, press fhe
, :"-:":w Leg. To am? this menu. press ESE

-;IIIII----------------A-------l---

Exhibit 5—1. Master Menu.
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For the Logic Analyzer Disk, the two categories are:

Logic Analyzer
Disk Utilities

Use the up-arrow and down-arrow keys to move the dark bar area over

"Logic Analyzer". Then press the right—arrow key. The list of

individual functions available will be displayed in the middle column:

Logic Analyzer
EPROM Programmer
Pattern Generator

To activate one of the functions, simply move the bar over it and

press <RETURN>. If you activate "Logic Analyzer", for example, the Omni

will load and begin running the logic analyzer program.

2;; gs; A WORKING DISK

Two copies of the logic analyzer software are provided, a Master

Disk and an Operating Disk. Put the Master in a safe place and use the

Operating Disk as your working disk. Only masters are provided for the

other software. Make working copies and set aside the masters before

using the other software.

See the Specifications Section for the type of disks required.

5.6 COPYING DISKS

All Omni models, both those equipped with the Master Menu and

earlier units, have convenient disk copy programs.

From the Master Menu select "Disk Utilities" and then "Copy a

Disk." A menu will appear with four choices - C, B, O, and E. But

before making a selection, remove the disk in Drive A and insert the
disk you wish to copy. This is the source disk.

Put a blank disk, the destination disk, in Drive B; this will

become the copy. (You can use a disk here that is not blank, but it

will be reformatted as part of this copy method and anything on it

previously will be erased.) After the prompt line, choose C:

Please enter selection. Press C, B, 0, or E ==>§

Note: your input is underlined here to distinguish it from data

displayed by the computer.

The program will then display some more information, after which

you type <RETURN>:

...press the RETURN key to start the copy operation. You

may return to the main menu by pressing any other

key.<RETURN>

Omni Operating Manual 5-4 Turn-on Procedure



Note: here "<RETURN>" means "press the RETURN key," not type the
characters "< R E T U R N >".

The program will display the track numbers as it makes the copy,
and will report errors if there are any. If there are errors, start the
copy operation over; if it does not work the second time, the
destination disk is probably bad - use another.

After the files are copied, the program will ask if you want a

special command line executed at boot-up. You do not, so merely type
<RETURN> to accept the default case.

The program then returns to its main menu. Choose "E" to exit.

...Press C, O, B, or E ==>§

The last step in making a copy is to label it. Do not write on the
label after it is on the disk with a pencil or ballpoint pen; you can
use a felt tip pen, which requires very little pressure. We suggest
that you include on the label the version of CP/M, the files on the
disk, and at the bottom of the label your initials and the date.

5.7 OPERATING THE LOGIC ANALYZER

To use the Omni as a logic analyzer, put the operating disk
(labeled "Omni Logic Analyzer Operating Disk") in Drive A. The Logic
Analyzer Disk must be in Drive A for the built-in Help Pages to be
accessible.

Press the Reset button. When the Master Menu appears, select
"Logic Analyzer" as described above. The computer will load the logic
analyzer program and run a series of self-tests. See Exhibit 5—2. If
you have the probes plugged in and connected to nothing, the tests will
be valid and the screen will display several messages reporting the
results.

These tests check out the logic analyzer hardware only, from the
ends of the probes to the sample collection circuitry. The tests will
be passed only if the probe cables are connected to the Omni and the
probe leads are "open" - not connected to anything. If the probes are
not installed, or if they are connected to a circuit, a failed test will
be indicated on the screen.

If one or more tests fail, the Omni will display failure messages
and stop. You may override the stop—on-fail by pressing <SPACE>; the
logic analyzer will then go on to the next step, which is the Trigger
Condition Setup Menu.

The following chapters describe use of the Omni Logic Analyzer for
digital measurements.

You can exit the logic analyzer program and return to computer mode
by using CONTROL—C whenever the input prompt (cursor) is in the lower
left corner of the screen.

Omni Operating manual 5-5 Turn-on Procedure
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inverting Probes

CUIZK CIRGJITRY TEST
TRIHSER (mm TEST
FRCK TEST

mm H-‘fl LCN LEVELTEST
mm am HIGL LEVELTEST
ELITOL Hi1 L01 LEVELTEST
GLITCH H11 HIG‘I LEVEL TEST

Test couplets with no er

Exhibit 5-2. Self-test display.

5.8 EARLIER MODELS

Earlier models of the Omni (1984 and prior) use the standard CP/M

disk directory user interface. The logic analyzer functions are all the

same.

The earlier models use the program COPY.COM to c0py disks. Put a

disk containing the CP/M operating system in Drive A and boot up (which

loads the operating system into the computer) by pressing the Reset

switch. The Reset switch is the red button on the rear panel of the

Omni II and 4- Don't flip the rocker switch and turn off the computer

by mistake.

If the disk with CP/M does not also have COPY-COM on it, put a disk

containing COPY.COM in Drive A before the next step. You can use the

DIR command to see if the disk has COPY-COM on it.

After the A0> prompt, type "COPY<RETURN>" to run the copy program:

A0>COPY<RETURN>

From this point, the program runs as described above.

Omni Operating Manual 5-6 Turn-on Procedure



To use the Omni as a logic analyzer, reset it and put the Logic
Analyzer Operating Disk in Drive A. To see a directory listing of the
files on the disk, after the "A0>" prompt type '®1R<RETURN>".

The directory will show at least six files. LA.COM and LA.LAO are

the logic analyzer program. LA.LAH contains the Omni’s on—line Help
information. DATA-1-.LAD, DATA-2-.LAD, and DATA—S-.LAS contain sample
data for this start-up exercise.

When the "A0>" prompt appears again after the directory listing,
type "LA<RETURN>". The Omni will load and begin running the logic
analyzer program, starting with the self—test as described above.

Rev. D
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6. BASIC OPERATION

The Omni’s basic operation may be summarized as follows:

1) Once connected to a circuit and told to "Go collect data", the
Omni begins to collect data into the 16 channels (or optionally 32

channels) of its Sample Memory from the circuit under test. The data is
"clocked in" - a new data sample of 16 bits, one bit for each probe data

line, is gathered with each clock pulse. The clock pulses are either
derived from the circuit under test (External Clock), or generated by
the Omni (Internal Clock). The Omni continually collects data and
records it in Sample Memory, overwriting old data as it cycles through
memory, until a trigger event occurs.

2) The recognition of a trigger word (chosen by the operator) in
the data stream causes the Omni to start a counter that defines the
number of additional samples to be collected. Data collection continues
so that the defined number of samples after the trigger word are

captured for observation. The number of samples from the trigger word
to the end of the trace is called the Trigger Point. The default value
is 500, which gives a trace with the trigger word in the center of the
lOOO—word Sample Memory.

3) The Omni then displays on the screen the data in its Sample
Memory. The display shows a history of the digital activity in the

circuit, both before and after the trigger word. The trigger word is at

the center of the screen.

Thus a logic analyzer, like an oscilloscope, collects data

corresponding to voltage versus time and displays it as "traces".

Two features make the logic analyzer a very powerful tool:

1) It can collect data on many lines at once; in this case, on 16

(or optionally 32) lines. Observing the bit stream on a single line at

one time, as with an oscilloscope, is of little value since the bit

pattern is meaningful only in comparison to the simultaneous bit

patterns on other lines.

2) The logic analyzer displays data prior to the trigger event, as

well as after. The oscilloscope only starts the trace at or after the

trigger event. When a digital circuit goes awry, the cause is usually
found in what happened beforehand, not afterwards.

0n the other hand, a logic analyzer has two limitations compared to

an oscilloscope. It records voltages as only "high" or "low" (binary i
or 0), ignoring the details of waveform shape. Also, it records the

logic level only at the active clock edge. This second limitation is
overcome to some extent by glitch capture capability, which alerts the
user to the presence of multiple transitions between clock edges. The
Omni's specifications guarantee detection of glitches as narrow as 10

nanoseconds, and it will typically record glitches as brief as 6 or 7

Omni Operating Manual 6—1 Basic Operation



nanoseconds, depending on the polarity.

The time scale resolution is limited to the minimum clock period
that the logic analyzer can handle. The Omni will accept a clock

frequency of up to 20 MHz, yielding 50 nanoseconds resolution. If finer

resolution is required, there is a Trigger Output on the rear of the

analyzer that provides an output pulse when the trigger word occurs.

This signal can be used to trigger a 200 MHz oscilloscope, giving far

greater resolution when a recurring trigger word is available.

After the data around the trigger event has been collected, it can

be displayed in a variety of formats for convenient study and

interpretation. The Omni’s display formats are:

Waveform Display - format similiar to timing diagrams in digital
data books.

Edge Waveform - same format as Waveform, however in regions where

the data is not active, the data is compressed so that only
regions of the Memory where the data is changing are

displayed.

Dump - format similiar to computer memory dumps where logic levels

are represented as numbers and grouped as hexadecimal, binary,
octal, signed or unsigned decimal digits.

Matrix — format where the numbers of occurrences of logic level

combinations are shown in a matrix format.

Instruction Disassembly — format where logic level patterns are

displayed as microprocessor instruction mnemonics.

Histogram - provides information on the amount of time a computer

spends executing different parts of a program, based on data

collected from the address bus.

Signature Analysis — calculation, display, and comparison of

signatures for up to fourteen circuit nodes at one time.

Scrolling through the data is facilitated by commands for direct

cursor positioning, cursor arrow keys, and a Locate command which finds

desired logic patterns. The ability to individually label each channel

aids in the readability of the display. With this feature, the names of

the circuit points to which the probes are connected can be displayed
directly on the screen.

Analysis is aided by displays which show time or number of samples
since the trigger event; commands which allow the calculation of sample
number and time intervals; and the correlation of the collected data

with data previously collected and saved on a disk file. The ability to

produce a printed version of any screen display allows several sets of

data to be collected for analysis at a later time or for use in

consultation with others familiar with the circuit under test. This

same feature can be used to produce a record of properly operating
circuits for later reference.

Omni Operating Manual 6—2 Basic Operation



Several features have been incorporated in the Omni to make it

user—friendly. Most data entry is via menus, with the cursor placed at

the position of current activity. Immediate feedback is given after

each keystroke, and prompts are given at appropriate times to inform you

of the type and range of inputs desired. The inputs are queued so that

you can type as fast as you desire without concern that keystrokes will

be lost (this applies to the logic analyzer program only; queuing
features vary for other programs when using the Omni as a computer.)
The cursor position is highlighted for easy location. At any time, you

can access a list of commands or information on any command. The format

of each command, applications, and examples of its use are provided by
the on-screen Help Pages. This feature virtually eliminates the need to

refer to this or other manuals once you are familiar with the Omni's

basic operation.
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7. CONNECTING THE PROBES

7.1 INTRODUCTION

The Omni has 22 input lines that connect via probes to points in

the circuit you are testing. The lines are:

6 Data lines

Clock

Clock Qualifier
Trigger
Trigger Qualifier
GroundsNr—ur—r—II—v—I

The 16 data lines collect the digital data which will be stored as

samples in the Sample Memory, then later displayed.

The Clock line allows data collection synchronously with an

external clock, such as a microprocessor system clock. You may not wish

to sample on every pulse of the system clock, but only on clock pulses
synchronous with some other event. The Clock Qualifier allows you to

use this second event to qualify the data collection.

Usually, you will be triggering on a certain combination of bits on

the data lines, called the trigger word. However, on occasion you may
'

wish to trigger on some external event. The Trigger line allows this.

You may also wish to qualify the trigger with some other event, and the

Trigger Qualifier line allows this. The Trigger Qualifier signal may

also be used as a seventeenth bit for word recognition.

7.2 INPUT PODS

The 22 lines connect to the Omni via two pods, 11 lines to each

pod:

Signal Signal Suggested
Pin Left Pod Right Pod Lead Color

1 Clock Clock Qualifier Yellow/White
2 DO D8 Black

3 D1 D9 Brown

4 D2 DA Red

5 D3 DB Orange
6 D4 DC Yellow

7 D5 DD Green

8 D6 DE Blue

9 D7 DF Violet

10 Trigger Trigger Qualifier Red/White
11 Ground Ground Green/White

The two pods connect via 36-inch, special high-flex ribbon cables

to connectors on the front panel of the Omni. See Exhibit 7-1. While
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Exhibit 7-1. Omni input leads and pods. The input connectors are inside
the opening in the front panel below the disk drives; the cables were not

plugged in when this photograph was taken.

facing the machine, "Left" and "Right" refer to the ribbon cable
connectors on the main unit; the "left pod" is whichever pod is plugged
into the left connector. The pods themselves are identical.

The right pod carries the eight high order channels, DF-D8. The
left pod carries the low eight channels, D7 through D0. of these, the
lowest four channels, D3 through DO, contain enhanced circuitry which
will capture glitches. If you wish to use glitch detection, connect the
low four channels of the left pod to the points you wish to test.

Otherwise, no special orientation is needed when connecting the probe
assemblies.

Each input pin at the buffer pod accepts a 6-inch test lead
terminated in a pushbutton "grabber" clip. The "grabber" is small

enough to attach to the pins of standard intergrated circuits, which
have 0.1 inch pin spacing. The grabbers hang on quite securely.

The Omni is normally supplied with 22 grabber clips and leads. The

clips are of special construction for secure connection to small,
closely spaced conductors such as integrated circuit pins. They are

designed to rotate so that the pods and leads may be moved about without
the clip twisting loose from the pin. The lead wires are made with over

100 tiny strands of copper for maximum flexibility and resistance to

breakage. The leads have a special locking connector that holds the
lead securely to the pod, yet releases easily when desired.
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Eleven of the clip-leads are ganged together, while the other

eleven are separate. The leads are color—coded to make channel

identification easier; we recommend that the various color leads be

plugged into the buffer pods in the order listed in the table above.

M :LL m ____CM05

The pods contain buffers that minimize the load on the circuit

under test while allowing the Omni to be several feet from the test

point. The input impedance of the pods is l megohm. Buffer pods are

currently available for two logic families, TTL and CMOS. The

appropriate one should be selected for the type of circuit under test.

A TTL level buffer pod is normally supplied with the unit. For

measurements on CMOS circuits, the CMOS buffer pod is preferred. It is

possible to utilize one TTL buffer pod and one CMOS buffer pod if

analysis is to be performed on circuits which contain both CMOS and TTL.

Where one pod is to be used for both types of logic, select the TTL pod.
Note the difference in threshold levels between the TTL and CMOS pods in

the characteristics listed below.

TTL Buffer Pod Characteristics:

logic level transition to low level at 0.8 volts

logic level transition to high level at 2 volts

minimum detectable pulse 10 nanoseconds

maximum voltage limits -.5V, +5.5V

imput impedance 1 megohmOOOOO
CMOS Buffer Pod Characteristics

logic level transition to low level at 1.0 volts

logic level transition to high level at 3.5 volts

minimum detectable pulse 10 nanoseconds

maximum voltage limits -.5V, +5.5V

input impedance 1 megohm00000
7.4 PROBE POLARTTY

The probe circuitry inverts the polarity of the signals. As part
of the powereon self-test, the Logic Analyzer program checks whether

inverting probes are connected or not and configures the software

appropriately. Thus if the probes are connected when you load the Logic
Analyzer program, the polarity will be correct. If you do not connect

the probes until after self-test, you will also need to call up the

Options Menu (0 Command) and change Item 5, Probe Type, from Non—

inverting to Inverting. Merely accessing the item toggles the entry
from one state to the other.

7.5 CHANGING TEST SETUPS

It is often convenient to utilize multiple sets of test clips when

changing from one test setup to another. Using this technique, it is

easy to go back to an earlier setup by swapping the test clips at the

pod rather than having to reconnect each of the eight test clips. This

feature is further enhanced by utilizing the file input/output features
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of the analyzer to save and restore channel identification labels.
Refer to the File Operations section for details.

Each pod has its own ground line. The ground line should always be

connected to a convenient ground position on the circuit under test. It
is usually a good idea, especially when glitches or high frequency
signals are being monitored, to place the ground clip near the probe
clips. This will produce the most accurate representation of the

signals as seen in the circuit under test.

NOTE:

Failure to connect the ground clip can cause misleading
information to be collected by the analyzer.

If, after connection to the test circuit, the probes should be

placed in the wrong pod, or the pods exchanged in their connections to

the front of the Omni, no damage will be done. However, any

interpretation of the collected data will likely be meaningless until
the inversion is detected and corrected.

7.6 CLOCK AND TRIGGER OUTPUTS

Clock Output and Trigger Output signals are available at the rear

of the Omni at connector pins mounted directly on the logic analyzer
data collection board. They are high speed, TTL level signals suitable
for triggering an oscilloscope or other digital processing equipment.
The outputs are isolated from the other circuitry through dedicated
74L304 buffers. Thus loading on these outputs will not affect logic
analyzer operation.

Exhibit 7-2 shows the connector pinout for the Clock Output and

Trigger Output. Each connector has two pins 0.025-inch square, spaced
0.1-inch apart. The top pin carries the signal and the lower pin is

ground.

The falling edge of the Clock Output signal is synchronous with the

sampling window for the Omni's data input lines. It is valid for both
Internal Clock and External Clock operation. The Clock Output’s active

edge is the falling (negative going) edge, regardless of the Clock

Polarity chosen for External Clock operation.

The Trigger Output signal is active high. It is valid for all
modes of trigger operation - Internal or External Trigger, Latched or

Unlatched, qualified by the Trigger Qualify or not. The Trigger Output
signal is derived from the trigger signal that actually initiates

completion of data collection in the Omni.

The Trigger Output signal may be used to trigger an oscilloscope
for examination of waveform shapes. For example, it may be desirable to

observe operation of power circuitry controlled by a single~chip
microcomputer system. Use the Omni to trigger on the digital
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CLOCK _____.:> <2 TRIGGER

OUTPUT OUTPUT

GROUND > < GROUND

Exhibit 7—2. Clock Output and Trigger Output connector pinouts. The

two connectors are accessible through vertical slots in the rear panel
of the Omni.

conditions, and the oscilloscope to examine the power signals. In such

a case, it may be desirable to force the microprocessor into a loop to

give a reasonable repetition rate for the scope trace.

The Trigger Output may also be used to trigger a wide bandwidth

oscilloscope for high resolution study of digital signals. For example,

with a 200 MHz oscilloscope, waveform details as fine as 1.5 nanoseconds

can be observed. By providing the necessary trigger signal to allow the

oscilloscope to display the digital events of interest, the Omni makes

possible ultra-high-resolution measurements beyond the normal capability

of either a logic analyzer or oscilloscope alone.

With the Omni operating in the Internal Clock mode, the Clock

Output may be used as a convenient signal saurce where an accurate,

stable digital clock signal is required. For example, the Clock Output

may be used as the clock source to test clock-driven digital circuits

such as counters, shift registers, and state sequencers. Since the

Omni’s data collection is synchronized to the clock, collecting state

data to track the operation of these circuits is very easy.
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8. MENUS AND COMMANDS

8.1 INTRODUCTION

The Omni needs three kinds of input from you to operate:

Trigger and sampling conditions for collecting the data — trigger

word, clock pulse polarity (for external clock), and so on.

This information is entered on the Trigger Condition Setup
Menu (Trigger Menu for short). The initial entries on this

menu default to the most commonly used values.

Go Command - causes the Omni to start collecting a new data sample
and looking for a trigger condition.

Display selection — set up the Omni to display the collected data.

The default display is the Waveform Display, which shows the

signals as a timing diagram. Also available are the Dump

Display, which lists the data as hexadecimal, binary, octal or

decimal numbers, and several other special purpose displays.

Two methods are used to control the Omni: Menus and Commands.

Menus are used to set up the event recognition method (either trigger
word in the input data stream or External Trigger signal), Sample Rate,
and other control parameters. Commands control the format in which the

collected data is displayed.

8.2 MENUS

The menus are called up by single letter commands. For example,
"0" will call up the Options Menu. The single letter suffices; it is

not necessary to press <RETURN>.

The menus and the letter commands that call them up are:

Command Menu called 22

Correlation Menu

File Operations Menu

Histogram Menu and Display
Locate Pattern Menu

Options Menu

Pattern Generator

Signature Analysis Menu

Trigger Menu

Complex TriggerNHm'UOf‘CI-‘n’flo
Each menu shows the present values of the parameters it controls.

On power-up, the most commonly used parameter values are installed as

defaults. See Exhibit 10-1 for an example of the Trigger Menu, the most

frequently used menu.
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To enter a new parameter in a menu item, type the item number to
move the prompt-cursor to the item, then enter the desired parameter
value. If the item has more than one data entry field, press <RETURN>
to move to the next field. For example, Item 3 on the Trigger Menu has
both binary and hexadecimal entry fields; press <RETURN> to move from
the binary field to the hexadecimal field.

Press <SPACE> to leave an item and return the prompt—cursor to the
lower left corner of the screen.

8.3 COMMANDS

Commands control the collection and display of data. Commands are
made up of a command letter and one or two optional parameters. The
commands that collect or display data are shown below. Optional
parameters are shown in square brackets, "[ 1".

Command Effect

Dlx] Numeric dump from sample x

E[x] Edge display from sample x

G Go collect data

I[x] Instruction disassembly from sample x

M[x[,y]] Matrix display from sample x to y
W[x[,y]] Waveform display from sample x to y
= Load trigger word and collect data

Additional commands that perform various useful functions are:

Command Effect

?[C/D,...] Help Pages for Commands C, D,...
N#xyez... Name Channel number # with xyz...
CTRL—P[x[,y]] Print copy of sample x to y
X[x[,y]] Calculate time between cursor, x, or y

When you enter the first letter of a command sequence, the format
for the rest of the command appears immediately on the prompt line. Do
not put a space after the command letter; the space is inserted
automatically. When you enter two numeric parameters, use a space to
separate them. All commands except "G" and "=" must be ended with
(RETURN).

As an example, consider the command:

W5<RETURN>

"W" calls up a Waveform Display of the most recently collected data-
The parameter "5" causes the display to start from Sample 5, the fifth
sample after the trigger event.

If you make an error in the middle of a command sequence, type"/<RETURN>" to abort the command, then re-enter the command correctly.
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Commands are accepted when the prompt-cursor appears in the lower

left corner of the screen,
\

Both lower and upper case characters are accepted; lower case is

treated internally as uppercase. The "W5" command could have been typed
as "wS" with the same result. The slash character "/" is accepted as

"?", a comma is accepted as "<", and a period is accepted as ">". Thus

one-finger typists do not need to use the shift key.

8.4 REPRESENTATION QE DIGITAL SIGNALS EX NUMBERS

As the name "digital logic" implies, electronic signals may be used

to represent numbers, and vice—versa. The basic form of representation
is binary, where, for example, an eight-digit binary number such as

"1001 0111" is used to represent the signals on eight electrical lines.

Each digit in the binary number is a "0" or a "1", representing a high

voltage level (H1) or low voltage level (L0) on the corresponding line.

Let us represent the form of the binary number like this:

abcd efgh

Here "a" represents the first bit, "b" the second, and so on. The

number may be evaluated by multiplying the bits by powers of 2 and

summing:

6 +...+h*20N = 3*27 + b*2

Thus "a" is the high-order bit, "b" is the next bit, and so on to "h",
which is the low-order bit. Extending the correspondance beween the

eight bits and the eight signal lines, we may apply mathematical

terminology to the signal lines. The line corresponding to the high—

order (leftmost) bit is the high-order line, and the line corresponding
to the low-order (rightmost) bit is the low—order line.

For the Omni, we call the signal lines channels. They are labeled

according to the powers of two in the binary number. Thus eight of the

channels are called Channel 7, Channel 6, and so on to Channel 0. We

may also call Channel 7 the high-order channel (in this group of eight),
and Channel 0 the low—order channel.

Binary numbers are difficult for people to deal with. When

expressing digital signals as numbers, it much more convenient to use a

number base such as decimal (base 10), hexadecimal (base 16), or octal

(base 8). Note, however, that the correspondence between the digits of

the numbers and the signals is lost when decimal is used. "173" may

represent the signals on Channels 7 through 0 very nicely, but the "7"

does not correspond to the signal on any one channel or group of

channels.

Hexadecimal representation is often preferred because each hex

digit does correspond exactly to the signals on four channels; a hex

digit is equal to four bits. A signal on the Omni’s 16 channels may be

represented by four hex digits, e.g., "9AC5". In this context, "9"

corresponds to the signal(s) on Channels F-C, "A" to Channels B—9, and
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so on. To interpret this in terms of signal levels, translate it to
binary. Thus "9" is equal to "1001" in binary, which means a HI level
on Channel F, LO on Channel E, L0 on Channel D, and HI on Channel C.

8.4 FORMAT FOR ENTERING NUMBERS

Most entered data is numeric and can be specified in a variety of
formats. All numbers are assumed to be in hexadecimal format, unless
indicated otherwise by a base suffix. To enter a number in another
base, such as decimal, append one of the following base specifiers:

Suffix Base
_ Valid Digits

B binary 0 and 1
D decimal 0,1,...,9
H hexadecimal 0,1,2,...,9,A,B,C,D,E,F

(default radix)
0 octal 0,1,2,...,7
U unsigned decimal 0,1,....9

Typical input values are:

Example Meaning

1234 decimal 1234
1234D decimal 1234
-1234 decimal negative 1234
47H hexadecimal 47 (i.e. decimal 71)
ABCDH hexadecimal ABCD (i.e. decimal 43,981)
10118 binary 1011 (i.e. decimal 11)
170 octal 17 (i.e. decimal 15)

The term "radix" is sometimes used as a synonym for "base."

The "sample number" for a given sample means the position of the
sample compared to the trigger event, which normally corresponds to

Sample 0. For example, in the "W5" command referred to earlier, the
number "5" indicated 5 samples after the trigger event. Samples before
the trigger event are indicated by a negative sample number such as "W—
5". Note that if a nonzero value is specified for the Delay on the
Trigger Menu, Sample 0 will be delayed with respect to the trigger event

by that amount.

If time units are desired rather than sample number, then the
number should be suffixed with time units. These units are:

Suffix Meaning

NS or N nanoseconds (.000000001 second)
US or U microseconds (.000001 second)
MS or M milliseconds (.001 second)
5

, seconds
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The command:

w5u<RETURN>

will generate a Waveform Display of the collected data with the sample 5

microseconds after the trigger event positioned at the left side of the

screen. Numbers are maintained to three significant digits after the

decimal point and you are allowed to enter numbers which contain decimal

points. The following examples illustrate some valid number

representations.

Example Meaning

500ns 500 nanoseconds after the trigger event

-5500us 5500 microseconds before the trigger event

-5.Sms same as previous example (i.e. 5.5

milliseconds before)

A number such as "500.75ns" is overly precise since the resolution of

the analyzer is limited to the nearest 50 nanoseconds. This number

would be accepted as "SOOns".

8.5 CURSORS

The Omni uses two cursors, called the prompt-cursor and the

highlight-cursor. The prompt-cursor is a blinking block or underline

that shows where characters entered from the keyboard will appear on the

screen. The highlight-cursor, also called the sample cursor, is a

highlighted area of the screen used to mark a certain sample in a

display. The highlight-cursor also uses either a vertical line to

indicate the marked sample (for the Waveform and Edge Displays) or a "<"

character (for the Dump Display).

8.6 DISPLAY CONTROL KEYS

Displays are controlled by the following keys:

52y Function

> scroll display one page to right
< scroll display one page to left

<- move highlight-cursor one position left

-> move highlight-cursor one position right
4 scroll display or highlighted item up one position
v scroll display or highlighted item down one

position
<SPACE> exit current menu or display

8.7 HELP INFORMATION

A list of all the commands appears on the Reference Card, Appendix
B at the end of this manual, and in abbreviated form on a label on the

keyboard. The list is also available on-line as two Help Pages; see the

next section for further information on the Help Pages.
Rev. D
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9- HELP PAGES

Help Pages may be called up as needed. Whenever the command line

Enter: C,D,E,F,G,H,I,L,M,N,0,P,S,T,W,X,Z,=,?,(sp),‘P

appears, a list of the menus and commands may be obtained by typing
"?<RETURN>" .

This list is the same as that given on the Reference Card at the

end of this manual, Appendix B. The first half of the list appears on

the screen immediately; to View the second half, press <SPACE>.

More detailed information about any menu or display command may be

obtained with a question mark followed by the command letter, for

example:

?W<RETURN>

A Help Page will appear that gives details on the format and use of the

W Command, which controls the Waveform Display.

The Help Pages are contained in disk files that are presented in

response to commands beginning with "?". The Logic Analyzer Disk must

be in Drive A for the Help Pages to be accessible.

After viewing a Help Page, press <SPACE> to return to the menu or

display you were viewing before.

The menus have additional Help Pages on-line for each menu item.

Type "?" followed by the number of the menu item to see a detailed

explanation of the item. For example, on the Correlation Menu, "?5"

gives a detailed explanation of Item 5, Starting Point Skew Allowance.

Exhibit 9-1 shows the Correlation Menu and the corresponding Help Page
for Item 5. After reading the explanation, press <SPACE> to go back to

the menu.

When the first letter of a command is keyed in, abbreviated Help
information for the command is automatically displayed. The information

appears as a prompt line that gives the format for the command or a

description of its effect.
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1) File to correlate with: lNTEBtRL

FEDCBR‘3376543 21
ZJChannelmask: 1111111111111

El) First sarrple included: 5
4) Nunber of sarrples: 1m
5) Starting skew allowanceta
6) Skew alignnent sangles: 1
7] 5.3an ing tolerance: 5
8) Channel (bit) toleranceia
9) Repeat data collection until: R

,'> R) [not active)
=53 B) Sailples correlate with reference

0 Samples do not correlate with reference

lndex 1-8, G to start, P, ?, or (space)

(a)

5) STRTIMG POINT SKEH RLLWCE

'n'e stirting point given in Item 3 specifies a sanple
other in the Eagle Yemen;and iuplies the sane in

Merence thnorg. [be to sanpl ing differences, these
to starting points nag not be exactly at the sane

swie nuizer. To account for this, Item 5 allows you
to skew the Reference t‘bmrg starting point sone given
value. The value entered is the maxirrum nuuber of

swles on either side of the iwlied starting point
that should be allond. For exanple, a value of 18 for
the starting point and 4 for the skew unuld wean that
the Reference tbmrg starting point could be anguhere
true 6 to 14.

Hit key to continue

0:)

Exhibit 9-1. Correlation Menu (3) and the Help Page for Item 5 (b).
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10. TRIGGER CONDITION SETUP MENU

10.1 INTRODUCTION

The trigger word and other trigger conditions are entered in the

Trigger Condition Setup Menu, Exhibit 10-1, usually called the Trigger
Menu for short. It is the first page that appears after self-test and

the command lists when you load the logic analyzer program, LA. You may

also call it up with the T Command.

For the simplest form of triggering, enter the desired trigger word

in Item 3, Trigger Event. The trigger word is expressed both in binary
form, which allows "don't care" bits (each denoted by an "X"), and in

hexadecimal form at the right of the binary field.

The menu format makes entering the trigger word very easy. Type
”3" to move the prompt-cursor to Item 3. The prompt-cursor will begin
blinking in the first column (labeled "Channel F" at the top) to Show

that the Omni is ready to accept an entry in that column. You can move

the cursor to another channel either by using the left and right arrow

keys, or by entering the channel designator "F" through "2" ("1" and "0"

are not available for moving the cursor since they are used as entry

symbols.) Key "5", for example, will move the cursor directly to

Channel 5.

Keying in a "1", "0", or "X" for a given channel sets the trigger
level for that channel to high, low, or "don't care", respectively. The

cursor then moves to the next channel.

The Omni also allows triggering on logic functions (AND, OR, and

NOT) of the bits in the collected samples. In order to facilitate this,
the sixteen channels are divided into four groups of four bits each.

The four groups are labeled "2", "y", "x", and "w". In addition,
Channels 3 through 0 have glitch triggering capability; the glitches are

considered Group g. Item E, Recognition Function, defines the logic
function of the five groups which initiates triggering. Type "E" to

move the prompt-cursor to Item E, then key in the number of the desired

logic function.

After setting the trigger conditions, type "G" for "Go and Collect

Data." The Omni will collect data, stop after the trigger condition is

satisfied, and display the new data in the current display format.

When you finish viewing a data display and are ready to reset the

trigger conditions to collect another sample, press <SPACE> to bring up

the Trigger Menu again. You can also reach the Trigger Menu by typing
IlTll ‘

If you wish to display less than all 16 channels, or wish to

display glitches on the lower four channels, Items 1 and 2 allow you to

set up those conditions.
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Channels FE

l) kiive Probes B]

2) the G|i1ch

Recog Groupings:
--

z
- : :

3)TriggerEven1 XXXXXXHXXXXXXXXXX
4)G|I1‘chEve-n1(g) X X X X

S) Trigger (halt X D) Recog Mode: LNLRTOiED

6) Trigger Point: 512 E) Recag Func1ion: 1

7) Occurrence C: l -> l—z-g-x-w-g
B) Delag: B 2-[z-g -w)+9
9) Tmeouf: a 3—[Wl-x-w
H) Clk (haliEg: X 4-(z-g)+[x-w)

X

58

C599
1

D
B

B] Ex1 Clock: S-z-g-(x’rwl
C) Sanple Rate: .flIS E-Exlernal

Index l-E, G'siafl, P-prinf, ?, (space)

Exhibit 10-1. Trigger Menu as it appears on the screen.

10 .2 SAMPLE CLOCK

The Omni uses a clock signal, called the sample clock, as its cue

to sample the logic level on the sixteen input lines. A sixteen bit

word, one bit for each channel, is collected on the active edge of the

sample clock. (The active edge may be either the rising or the falling
edge.) The sample clock may either be a signal generated by the Omni

itself (Internal Clock), or a signal derived from the equipment under

test (External Clock).

Use of the Internal Clock is often referred to as asynchronous
sampling (not synchronous with signals in the equipment being tested),
or "timing analyzer mode." To activate this mode, enter a Sample Rate

in Item C. The default mode is Internal Clock mode with a Sample Rate

of 50 nanoseconds (50 nanoseconds beween samples). Using the Internal

Clock, the clock edge used (rising or falling) is not meaningful to the

measurement and is not specified.
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Use of the External Clock is often referred to as synchronous
sampling, or "state analyzer mode." To activate this mode, enter the

desired clock edge, "1" or "0" (rising or falling), in Item B; Item C

will be updated to show "External Clock" automatically.

There is often some confusion between clocking and triggering when

using a logic analyzer for the first time. It takes 1000 clock edges to

fill the trace memory with 1000 samples. It takes only one trigger
event to stop data collection and give a display. We recommend that you

always use Internal Clock and manual trigger for your first measurement

in any testing. That will show you the signals on the input lines, no

matter what they are. We also recommend that you go through the Quick
Start procedure (Appendix A) the first time you attempt to use the Omni.

10.3 GLITCHES

A "glitch" is a narrow pulse, usually created as a spurious by-
product accompanying state changes in a logic system. Address decoders

and other multi-gate circuits often produce glitches when some parts of

the circuit respond slower than others, yielding illegal states that

last for less than a clock cycle.

In synchronous (clocked) logic, glitches are usually harmless since

they occur between active clock edges, and hence are ignored. Some—

times, however, they cause trouble, and when they do, the Omni may be

used to detect them and isolate the source.

Basic logic analyzer circuitry, which collects data only at the

active clock edge, will not normally detect glitches. The Omni contains

latches that follow the incoming data stream; if two or more level

transitions occur within one clock period, that is considered a glitch.
Detection of the glitch is recorded in a special glitch memory. When

glitches are present and glitch display is activated, glitches appear on

the Waveform Display as narrow pulses.

Channels 3 through 0 have the ability to capture glitches. Item 4,
Glitch Event, controls triggering on glitches. Enter a "l" to activate

glitch triggering on a given channel, or an "X" to disable. The glitch
polarity is not significant; when a "1" is entered, the Omni will

trigger on glitches of either polarity in that channel. Entering a "O"
has the same effect as entering a "1".

If glitch triggering is activated for more than one channel,
appearance of a glitch on any one activated channel will satisfy glitch
recognition.

10.4 : COMMAND

The = Command is a combination command that allows you to both

change the trigger word and initiate triggering at the same time. To

use it, line up the sample cursor, in the Waveform or other data

display, on the word you wish to use as the new trigger word. Then type
"=" to load the word marked by the cursor into Item 3, Trigger Event,
and start data collection. When you use the "=", the trigger event will
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be the value displayed at the trigger position. Any channel that is not

displayed (i.e., not active) will take on an "X" (don't care) value in
the trigger word.

10.5 TRIGGER POINT AND DELAY

A trace of approximately 1000 samples is collected during each data
collection run (approximately 500 samples when using the 32 channel

adapter). Normally, the trigger event will correspond to a point
approximately in the center of the trace, so that there are 500 samples
before the trigger event and 500 samples after the trigger event.

The sample corresponding to the trigger event is normally labeled

Sample 0. The other samples are numbered relative to the trigger event;
thus Sample 5 is the fifth sample after the trigger event, Sample —10 is
the tenth sample before, and so on.

Sometimes it is desirable to observe samples that are more than 500

sample clocks before or after the trigger event. Two menu parameters,
the Trigger Point, Item 6, and the Delay, Item 8, make it possible to

do this. Exhibit 10-2 shows how these two parameters skew the collected
data in time relative to the trigger event.

lOOO DATA SAMPLES

f——/\—\
TRIGGER J/SAMPLE‘5

EVENT

\ /
v

DELAY

TIME —9

Exhibit 10-2. Relationship between the trigger event, Delay, Trigger
Point, and Sample 0. The ability to specify independently the Delay and

Trigger Point makes it possible to View data before, after, or long
after the trigger event. Note that when the Delay is 0 (the default
case), Sample 0 is simultaneous with the trigger event.
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The Trigger Point defines the number of samples that the trace

extends past Sample 0 (which normally corresponds to the trigger
event). For example, a value of 96 will cause 96 samples to be saved
after the trigger, and thus approximaterly 900 before; the trace will
extend from (approximately) Sample -900 to Sample 96. The default value
for the Trigger Point is 512, which puts Sample 0 in the middle of the
collected data.

By setting the Trigger Point to 992, 992 samples after the trigger
event may be observed. If data is to be collected at some longer time

period after the trigger event, then 3 Delay parameter (Item 8) can be

specified. This will skew the collected data some specified time after
the trigger. The value of the Delay corresponds to the time difference

(expressed as a certain number of sample clocks or as an absolute time

value) between the trigger event and Sample 0. Thus when a non-zero

Delay is present, Sample 0 does not correspond to the trigger event.

Only positive delay values are allowed. (The capability of accepting
negative delay values has not been implemented, as this would require
that the instrument be capable of predicting the future.)

10.6 £11 EXAMPLE

The availability of many different trigger parameters vastly
increases the Omni's power to isolate and capture a particular event.

For example, assume that you have an eight bit microprocessor system
that is supposed to be moving a zero out of the accumulator at a certain
instruction in its program, but sometimes a non—zero number appears and

disrupts system operation.

To capture this event, you could connect Channels 7 through 0 to

the lowest eight address lines, and Channels F through 8 to the data
bus. For the Trigger Event, enter the lowest eight bits of the address
of the critical instruction in Channels 7 - O, and zeros in Channels F -

8. Use Section 3 of the Recognition Function (Item E) to achieve

triggering when Channels 7 — 0 equal the Trigger Event and Channels F —

8 do 325 equal the Trigger Event. With these conditions, whenever the
critical instruction moves a non-zero number out to the accumulator and
onto the data bus, the Omni will trigger on that event and display both
address and data bus information before and after.

10.7 MENU ITEMS

Detailed explanations of the individual menu items follow. To
enter a parameter in a menu item, first press the key corresponding to

the number of the item, e.g. press "1" to move the prompt-cursor to Item
1. After the change has been made, press <SPACE> to leave the item and
return the prompt-cursor to its home position at the lower left.

Item 1) Active Probes

This item has two functions. One, it shows the instantaneous logic
levels on the input probe lines for the channels that will be included
in the data displays. Two, it shows which channels will be included in
the data displays, and provides a way of selecting the channels which
will be displayed.
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A high or low logic level on each input probe line is indicated by
a "l" or a "0". The level display is updated several times a second and

a varying logic level will cause the display to flicker between "0" and

"1". Channels not included in the displays will have a blank space in

the corresponding bit position in this item.

To activate a given channel for display, first press "1" to move

the cursor to this item. Then keys "F", "E", "D", ... "0" will activate

the corresponding channel. Or, use the "<-" and "->" cursor keys to

move the cursor to the desired channel, and press any other key except
”X". To deactivate a channel, press the "X" key. The keys auto—repeat.

Note that when you move the cursor to a channel, the channel label

appears to the right under "Signal".

Exit this item with <SPACE>.

This item affects only the display format; it has no effect on data

collection (data is always collected on all channels) or triggering.

Item 2) Active Glitch

This item selects the channels for which glitches will be displayed
on the Waveform and Edge Displays. Channels with a "#" symbol will

display glitches, others will not. Glitch capability is limited to

Channels 3 through 0. To activate a given channel, first press "2" to

move the cursor to Item 2; then key "3" or "2" will move the cursor to

the corresponding channel and activate it. Or, use the "<—" and "->"

cursor keys to move to the desired channel, then press any other key
except "X" to activate it. To deactivate the channel, press the "X"

key. Press <SPACE> to leave this item.

This specification affects only the display format; it has no

effect on data collection (data is always collected on all channels) or

triggering. Glitch display can be activated only for channels also

active in Item 1.

Item 3) Trigger Event

When the Omni encounters the word entered in this item in the data

stream, it will trigger, stop data collection after the specified number

of additional samples, and display the collected data. To set the

trigger condition for a given channel, move the cursor to that channel.

Keys "F", "E", . . . "2" will move the cursor to the corresponding
channel, or the "<-" and "->" cursor keys may be used. For each

channel, enter a "1" to choose a high logic level as the recognition
condition, or a "O" to choose a low level. Enter an "X" to choose a

"don't care" condition. Item 3 defaults to all "don't cares" on power-

up.

After entry, the trigger word also appears in hexadecimal notation

at the right of Item 3. "Don’t care" bits are valued at 0 in the

translation to hexadecimal. To enter the trigger word directly in

hexadecimal, press <RETURN> to move the cursor into this field from the
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binary field. Direct hexadecimal entry does not allow "don’t cares."

Press <SPACE> to leave this item and return the prompt-cursor to

the lower left.

Item A) Glitch Event (g)

Any of the four channels in Group w can enter into the recognition
event by entering a "1" when the cursor is positioned at the desired

channel. No glitch is an "X". The cursor positioning commands are the

same as for Item 3. Unlike the Trigger Event, however, the glitch
channels operate on an OR logic condition. If any one (or more) of the

selected glitch channel detects a glitch, recognition occurs.

Item 5) Trigger Qual.

Trigger qualification can be specified by entering a "O" or "1" in

this item. "X" disables trigger qualification. "1" indicates that the

probe Trigger Qualify line must be at a high logic level before an event

can be recognized; when the input line is at a low level, all data input
to the event recognizer is ignored. "0" indicates the opposite
condition, that is, the event can only be recognized when the Trigger
Qualify input is at a low level. Essentially, the Trigger Qualify acts

as a 17th channel (or as a 33rd channel when the 32 channel option is

installed) for trigger event recognition.

To use Trigger Qualification, Line T on Probe Pod 8 (right pod)
must be connected to the trigger qualifying signal.

Item 6) Trigger Point

A IOOO-sample trace is collected about the trigger event during
each data collection run. The number of samples that the trace extends

past the trigger event (which normally corresponds to Sample 0) is

specified with this item. A value of 90 will cause 90 samples to be

saved after the trigger, and thus approximately 900 before. A value of

500, the default condition, puts the trigger event approximately in the
middle of the collected data.

Item 7) Occurrence #

This specifies the number of times the trigger event must occur

before recognition takes place. An occurrence is counted each time the

trigger pattern goes from a state where the signal does not match the

trigger pattern, to one that does match the trigger pattern. The length
of time for a match or no—match condition has no bearing on the

occurrence counting. Selection of l to 15 occurrences is supported.

Item 8) Delay

Usually data will be collected immediately around the trigger
event. However, if data is to be collected at some time period after
the trigger event, then a delay can be specified. This will skew the
collected data some specified time after the trigger. The delay can be

specified as a certain number of sample clocks or as an absolute time
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value. Absolute time delay is selected by using suffixes to indicate

time units: "ns" or "n" for nanoseconds; "us" or "u" for microseconds;
II II"ms" or m for milliseconds; and "s" for seconds. No suffix implies

that the delay parameter represents number of samples, rather than time

units. Depending on the sample rate, the delay can range from 16

microseconds to 34 seconds. Only positive delay values are accepted.
The delay and timeout resources are shared, so that when either is

selected, the other is disabled.

Item 9) Timeout

This function provides a means of detecting when a certain pattern

(which normally occurs repetitively) is absent for a specified time or

longer. The pattern is entered in Item 3, Trigger Event, and the time

limit, called the Timeout period, is specified in Item 9. If a Timeout

period goes by during which the (normally repetitive) event has not

occurred, then a trigger will be generated and data collected.

For example, consider the case of a microprocessor—based controller

which is required to poll several input devices periodically. If the

controller fails to respond to a service demand within a certain time, a

fault condition occurs. This can be caused by the processor getting
"tied up" spending too much time on one task. To solve the problem, it

is necessary to identify which task is tying up the processor when a

fault - failure to poll the input device — occurs. Set up the Omni to

collect microprocessor addresses, which will identify program tasks.

Set up the triggering so that Item 3, the Trigger Event, corresponds to

polling of the critical imput device. For the Timeout period, enter a

time value equal to the normal interval between the polls of the input
device. Then when the input device is not polled on schedule, the Omni

will execute a trigger sequence, that is, halt data collection and

display the data. The addresses of the offending time—consuming task

will be captured in the data.

The Timeout period depends on the Sample Rate and can vary from 16

microseconds to 34 seconds. It can be specified either as a certain

number of sample clocks or in time units. Enter time units in the same

way as described above for Delay, Item 8. The Delay and Timeout

resources are shared, so that when either is selected, the other is

disabled.

Item A) Clk Qualify

Sampling normally occurs on every cycle of the signal (external or

internal) being used as the sample clock. If there are periods when

data collection should not be performed, the Clock Qualify line can be

used to limit the collection to only the desired periods. For example,
it may be desired to collect only data bytes sent to a particular I/O

port. This may be achieved by using the I/O write strobe as the

External Clock, and using the decoded port select signal in the port

circuitry for Clock Qualify.

Entry of a "l" in this item causes data to be collected only when

the Clock Qualify line is high. A "0" enables data collection only when

the Clock Qualify line is low. If no qualification is desired, enter an
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"X" to specify the "don’t care" condition.

To use Clock Qualification, Line C on Probe Pod B (right pod) must

be connected to the clock qualifying signal. In the example above, that

would be the decoded port select signal.

Item B) Ext Clock

When synchronous data collection is to be performed, the External

Clock selection should be used and the desired sampling edge specified.
If the sample is to be saved on the low to high transition of the clock,
enter a "1" (positive going) edge. A negative going edge is selected

with a "0" entry. To deselect the External Clock, either enter "X" in

this item or specify an Internal Clock Sample Rate in Item C.

To collect data with an External Clock, Line C on Probe Pod A (left
pod) must be connected to the signal in the equipment under test that is

to be used as the clock signal.

Clock rates up to 20 MHz (50 nanoseconds) are supported.

Item C) Sample Rate

When the Internal Clock is used, a Sample Rate must be chosen. The

Sample Rate can be varied from 50 nanoseconds (20 MHz) to 32

milliseconds (30 Hz). For high speed data collection, rates of 50ns,
lOOns, 200ns, and SOOns are available. If a rate that is not available

is selected, then the next faster available rate will be used. Slower

rates can be selected in one microsecond intervals up to 32.766

milliseconds. To specify the sample rate, enter the desired rate

followed by a time unit suffix, "n", "u", "m", "ns", "us", "ms", or "s".

Item D) Recog Mode

The Recognition Mode may be Latched or Unlatched. That is, trigger
recognition can be performed on data as it passes through the

recognizer, or the data can be latched by the sample clock prior to

recognition. The Unlatched mode is appropriate when high speed signals
of potentially short duration are being detected. The Latched mode

should be used when monitoring a data bus type circuit, where data is

considered valid only during the clock edges. Selecting this item

toggles (changes) the Recognition Mode from Unlatched to Latched, and

vice-versa.

Item E) Recog Function

The sixteen data channels and four glitch channels are organized
into five groups labeled "2", "y", "x", "w", and "g". These groups may
be combined via this item to allow triggering on various logical
combinations of data and glitch. For example, Function 1, "z.y.x.w.g",
requires that the l6 data lines match the Trigger Event specified in

Item 3, £22 that a glitch appear on one of the channels specified in the

Glitch Event, Item 4.
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If no Glitch Event (Item 4) is specified, Function 1 will be

satisfied when only the Trigger Event (Item 3) is satisfied.

Function 2, "(z-y.x.w)+g", requires only that the Trigger Event 23
the Glitch Event be satisfied; not both.

Function 3 is "(ETy).x.w". Here the overbar symbol means logical
negation, that is, "2" means "not 2". Since "g" does not appear,
Function 3 applies only to the sixteen data lines. It is satisfied

when, and only when, all three of the following conditions are true:

Channels F through C (Group 2) do not match the data event; Channels B

through 8 do not match the data event; and Channels 7 through 0 (Groups
x and w) do match the data event. "Not match" for a group means any one

(or more) bits within that group failing to match.

Function 4, "(z.y)+(x.w)", also applies only to the sixteen data

lines. It is satisfied when either Channels F-8 (z and y) or Channels

7-0 (x and w) match the data event.

Function 5, "z.y.(x+w)", is satisfied when Channels F—8 (z and y)
match the data event, and either Channels 7-4 (x) or Channels 3-0 (w)
match the data event.

If Function 6, External Trigger, is selected, then you must also

specify the edge of the trigger pulse on which triggering shall occur.

Enter "1" for a leading (rising) edge or "0" for a trailing (falling)
edge.

To use an External Trigger, Line T on Probe Pod A (left pod) must

be connected to the signal in the equipment under test that is to be

used as the trigger signal.

10.8 HELP PAGE

When you are viewing the Trigger Menu, you can access Help Pages
for Items 1, 2, etc. by typing "?1", "?2", etc. Press <SPACE> after

viewing a Help Page to return to the Trigger Menu itself. Help
information for the Trigger Menu as a whole may be accessed by typing
"?T" when the prompt-cursor appears at the lower left corner of the

screen.

10.9 COMPLEX TRIGGER

The Complex Trigger Function allows triggering on a sequence of

trigger words, rather that a single trigger word. This capability is

also called sequential triggering or multilevel triggering by some logic
analyzer manufacturers.

Type "Z" to bring up the Complex Trigger Menu, which controls this

function. Exhibit 10—3 shows an example of the menu.
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Exhibit 10-3. Complex Trigger Menu.

Calling up the menu enables the Complex Trigger Function. When it

is enabled, the trigger pattern is governed by the entries on this menu

rather than by Item 3 on the Trigger Menu.

The successive trigger words are entered in Items 2 through 8 of

the Complex Trigger Menu. The trigger words must occur in the order

listed for triggering to occur. That is, each trigger word must have

appeared in the data stream and been recognized before the Omni is ready
to recognize the next word. The Omni initially watches for the first

word. Once that has been recognized, it watches for the second word
and so on. After the last word occurs and is recognized, the Omni

completes the data collection and displays the data in the usual way.

There is a delay following recognition of a word in the trigger
sequence, called the Setup Delay, until the Omni is ready to recognize
the next word. Occurrences of the next word in the data stream before

the Setup Delay has expired will be ignored. The Setup Delay has a

minimum value of 100 microseconds. Greater time values may be entered

in the menu.

The menu also includes a Trigger Mask (Item 1) to limit recognition
to a subset of the total sixteen channels.
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Accessing Item 9 toggles the Complex Trigger Function between
enabled or disabled status; when it is disabled, normal triggering as

defined on the Trigger Menu governs the trigger method. The Complex
Trigger Function is disabled at power-up.

10.10 EXAMPLE QE_COMPLEX TRIGGERING

Many computer software bugs can be localized by collecting the
addresses of instructions as they are executed. Studying the flow of
program control will reveal which part of the program is at fault.

However, programs often use nested subroutines, or subroutines
called from several places in the main program, to perform a complex
series of steps. In such cases, there are many "execution paths" that
the program may take. Often a troublesome problem is associated with
only one execution path. A subroutine may perform correctly sometimes
but misbehave other times, depending on where it was called from in the
main program. To locate the bug, you need to focus data collection "by
path."

The Complex Trigger Function allows you to do exactly that. Enter
as trigger words the calling addresses of the successive subroutines in
the path you wish to study. The Omni will collect data around the last
trigger word, which becomes Sample 0 (typically) in the displayed trace.
The sample data will reveal the system behavior that results from that
particular path.

10.11 COMPLEX TRIGGER MENU ITEMS

Item 1) Trigger Mask

Not all probe lines need be included in the trigger words. A "1"
in a given bit position means that the corresponding bit is considered
by the recognition circuits. An "X" means the bit is ignored. The
Trigger Mask word is also automatically displayed to the right in
hexadecimal notation, where each "X" is assumed to have a value of 0.

Items 2) Trigger Word and Setup Delay

Enter the first trigger word following the "2)". If you wish to

specify a setup delay value, use the right-arrow cursor key to move the
cursor to the Setup Delay field. Merely press <RETURN> to get the
default delay of 100.0 microseconds.

Items 3) through 8)

Enter additional trigger words and (if desired) setup delay values
in these items.

Item 9) Complex Recognizer Enabled/Disabled

Accessing this item toggles the Complex Trigger Function between
enabled and disabled status. The disabled condition allows you to
return to single word triggering (that is, Item 3 on the Trigger Menu
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again determines the trigger word) without disturbing the list of words
in Items 2 through 8.

10.12 COMPLEX TRIGGER HELP PAGE

To display information for the Complex Trigger function, type "?Z"
when the prompt-cursor appears at the lower left corner of the screen.

To display information for the individual menu items when viewing the

menu, type "?l", "?2", and so on. After viewing the information, press
<SPACE> to return to the menu itself.

Rev. D
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11. OPTIONS MENU

11.1 INTRODUCTION

The Options Menu (Exhibit 11-1) controls various aspects of the
data displays: output number base, sample or time units on the Waveform
and Edge Displays, display Sample or Reference Memory, enable modem,
probe type (inverting or non-inverting), and disassembly status lines
available or not (for the Instruction Disassembly function).

To call up the Options Menu, type "0<RETU'RN>".

1] Output nurrber base: BINFRY

215- I'E/Tim units on waveform: Smrple Divisions

3] [lisplag sample or reference mermr-g: Simple

4) Enable modem: In O'ilg

5) Probe type: Invert ing

Enter index 1—6,7, P, or (space) to exit

Exhibit 11-1. Options Menu as it appears on the screen.
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11.2 MENU ITEMS

To enter a new parameter in one of the menu items, type the item

number in order to move the prompt-cursor to the desired item.

Following are explanations of the individual menu items:

Item 1) Output number base:

The default output number base is hexadecimal. The menus and

displays that show the data in alphanumeric form (Dump, Matrix, and

Trigger Setup) use the number base specified in this item.

In hexadecimal notation, the 16 channels are organized into groups

of four, and the value contained in each group (each four bits) is

displayed as a single hexadecimal digit. The number base can be changed
to octal (groups of 3 channels), binary (each digit represents one

channel), or one of two decimal representations. The signed decimal

grouping treats the Channel F value as the sign bit of a twos complement
number. The unsigned decimal format allows only positive values.

After moving the cursor to this item by typing 1, enter one of:

octal, B for binary, D for decimal, H for hexadecimal, 0 for octal, or U

for unsigned decimal.

Item 2) Sample/Time units on waveform:

The Waveform and Edge Displays contain a graticule scale which

indicates the position of each sample displayed relative to the trigger
event. This scale can be labeled either with number of samples before

and after the trigger point, or with time units before and after the

trigger point. Selecting Item 2 toggles the scale labeling between

these two cases. When time units are selected, the values will be

displayed in an engineering format to three significant digits. Units

of nanoseconds (ns), microseconds (us), or milliseconds (ms) are used.

Item 3) Display Sample or Reference Memory:

When data is collected, it is automatically stored in Sample Memory
and displayed in the current display mode. It is also possible to load

previously collected data into Reference Memory, and then display the

Reference Memory. This facility is useful for making comparisons
between two sets of collected data, such as when the correlation

function is used.

There are two ways of loading data into Reference Memory. It may

be transferred there from Sample Memory, or it may be retrieved from a

file previously saved on disk. Sample to Reference transfer is perormed
via the File Menu. File to Reference transfer can be done from the

Correlation Menu or File Menu.

When Reference Memory is selected, all subsequent displays will

show it until Sample Memory is again selected or a new data collection

is made with the G or "=" Commands. Selecting Item 3 toggles between

Sample Memory and Reference Memory.
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Item 4) Enable modem:

The Omni 4’s internal modem is controlled by this item. Accessing
Item 4 toggles the modem status between enabled and disabled. When the

Logic Analyzer Program is first loaded, the modem is enabled for input
(that is, input from a phone line through the modem will be treated the

same as input from the keyboard) and disabled for output (output is sent

to the screen, not the modem line).

"Enable" (first access of Item 4) enables the output as well as the

input. This allows you to dial up the Omni from a remote location, and

control the logic analyzer from the remote location. Transmit "0" to

access the Options Menu, then "4" to enable the modem. Once enabled,
output goes to the modem rather than the screen. This gives you full

control of the Omni over the phone connection. Note that until this

full control is established, you will not have any feedback over the

phone line -

you have to send the "O" and "4" blind.

"Disable" (second access of Item A) disables both modem input and

output, returning full control to the local keyboard and screen. To

return to the initial state, it is necessary to exit and then reload the

Logic Analyzer Program.

Item 5) Probe type:

The Omni software can accomodate either inverting or non-inverting
probes. Accessing this item toggles a software switch between lnverting
and Non-inverting settings. All present OmniLogic probes are of the

Inverting type, which is the default case for this item. This function

is included to provide flexibility for possible future options. It may

presently be used where display of negative logic is desired.

11.3 HELP PAGE

The Help Page for the Options Menu may be accessed with "?O". When

viewing this Menu, Help Pages for Items 1, 2, etc., may be accessed with

”?l", ”?2", and so on. When you finish viewing the Help information,
press <SPACE> to return the Options Menu itself.

Rev. D
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12. GO AND START DATA COLLECTION

12.1 INTRODUCTION

After the probe leads are connected to your circuit and you have
entered the appropriate data collection parameters in the Trigger Menu,
type "G" to initiate data collection.

The G Command instructs the analyzer to start collecting data using
the sampling characteristics defined on the Trigger Menu. With each

active clock edge, one sample is collected from the data input lines and
loaded into the Sample Memory. The analyzer collects data until the

trigger event specified on the Trigger Menu appears. It collects a

defined number of samples after the trigger event, and then data

collection stops and the data is displayed.

The number of samples collected after the trigger event is defined

by the number specified in Trigger Menu Item 6, Trigger Point. The

sample collected at the time of the trigger event is labeled Sample 0 in

the data display. Thus in the display, the Trigger Point is the number
of samples from Sample 0 to the end of the trace.

If the trigger event does not occur, the analyzer will continue to

collect data indefinitely. Likewise, if the sample clock stops after

the trigger event but before the number of samples called for in Item 6
has been collected, the analyzer will not complete the trace. In both
of these cases, the analyzer appears to be waiting. If triggering does
not occur after a reasonable length of time, press any key except
<SPACE> to end data collection, initiate a manual trigger, and display
the data collected to that point.

Pressing <SPACE> will abort sample collection without a trigger and

return to the Trigger Menu. The data in the Sample Memory will not

change.

The "=" Command, like the G Command, also initiates data
collection. However, before starting data collection, it enters the

sample marked by the sample-cursor as the trigger word in Item 3 on the

Trigger Menu. See Chapter 10 for more information on the "=" Command.

12.2 DISPLAY FORMATS

Command Display Mode

W Waveform Display
E Edge Display
D Dump Display — hexadecimal, octal, binary or

decimal listing
I Instruction Disassembly Display
H Histogram Display
M Matrix Display
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Upon completion of data collection, the Omni will display the data

in Sample Memory in cm. the above six display modes — whichever one

was used last. On firm; use, the Waveform Display appears. A different

display mode may be selected by typing the appropriate command letter,

"w", "E", "D", "I", "H", or "M", followed by <RETURN>.

12.3 HELP PAGE

To display the Help Page for the G Command, type "?G".

Rev. D

Omni Operating Manual 12—2 Go Command



l3. WAVEFORM DISPLAY

13.1 INTRODUCTION

The Waveform Display gives a simultaneous view of up to 16 channels
of digital information that was collected by the Omni. The format is
similar to timing diagrams found in digital data books, and is

particularly helpful for hardware troubleshooting. It is the default
display mode at turn-on. The collected data will be shown in the
Waveform Display until another display format is chosen.

13.2 SCREEN CHARACTERISTICS

An example of the Waveform Display is shown in Exhibit 13-1. The

display is 80 samples wide. A sample was collected for each cycle of
the signal used as the sample clock. Since the maximum clock rate is 20
MHz, the finest resolution that can be obtained with the Waveform

Display is 50 nanoseconds between samples. (Waveform details can be
viewed to higher resolution by using a wideband oscilloscope and the

Trigger Output signal; see Section 7.)

Features of the display are:

Channel labels - at left side of the screen. The default labels
are DF, DE, and so on through DO. The additional 16 channels
available with the 32 channel option default to AF through A0.
The labels shown in Exhibit 13-1 (DATA7, MREQ, etc.) are

user—selected labels entered using the N Command.

Waveforms — show the high and low logic levels versus time on the
sixteen data lines.

Glitches - shown as narrow pulses if glitch display is enabled and

any glitches are present.

Movable highlighted cursor - marks Sample -466 for further
attention.

Graticule - beneath the waveforms. Identifies the samples
relative to the trigger point, and is calibrated with either

sample numbers or time divisions (as specified in the Options
Menu, 0 Command).

Hex codes - in vertical columns beneath the graticule. Represent
the hexadecimal equivalents of the data above. "FCSZ" is
marked by the cursor and highlighted by increased brightness.
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WFCACZFGCZFMCZFCdCZFCBBFWdCZFMCZFOdQFCIIC2FC4C2FC4C2F04CZB3F
WMWMGBMQMMMMWMMMBCH
WHISBNISBUIEWISBI7158226622778171511715817158171581715617158171222
FFFFFFFFFBIZFEIZFBIZFQIZFEIZFENQDECDFBRFQIZFQIZFEIZFBIZFEIZFBIHB
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Exhibit 13-1. Waveform Display. The W Command causes data in the

Sample Memory or Reference Memory to be displayed in this format. Also,
if the data was last displayed in this format, new data collected in

response to the G Command will also be displayed in this format.

Rate - indicates either the Sample Rate, when the Internal Clock is

being used, or External Clock, when an external source is

being used as the sample clock. When Internal Clock is used,
the Sample Rate is expressed in time units, typically
nanoseconds.

Delay - indicates the Delay (of Sample 0 compared to the Trigger
Event), 3 data collection parameter specified on the Trigger
Menu (Item 8).

Window - to the right of the Delay. The bright area shows where

the 80 samples displayed lie in the total lOOO—sample memory.
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SM or RM - to the right of the window. Indicate whether the data

being displayed is in the Sample Memory or the Reference

Memory.

<G or G> - if shown, mean there are glitches to the left or the

right of the cursor. <G> indicates glitches to both the right
and the left.

ref: - indicates the sample used as a reference by the X

Command, that is, the sample from which an interval is

measured. The X Command is a utility that calculates the

interval, in number of samples and time, beween two samples.
See Section 16 for further information on the X Command.

cur: - identifies the position of the highlighted sample cursor

relative to the trigger event (Sample 0). When the Internal

Clock is used, the time interval between the sample marked by
the cursor and Sample 0 can be calculated, as it is equal to

the number of samples in the interval times the Sample Rate.

The Omni calculates the time interval and displays it here.

? - at lower left. This is the home position of the prompt-
cursor. Commands entered by the user appear here.

Enter: - shows the commands which may be entered next. Press

<SPACE> or the "T" key to return to the Trigger Setup Menu.

13.3 COMMAND FORMATS

The Waveform Display is controlled by the W Command by using one of

the following command formats:

W Display data as waveforms while centering the sample marked

by the highlighted cursor in the previous display. For

example, if you wish to move the display 20 samples to the

right, move the cursor 20 samples to the left of center and

press "W<RETURN>". The display will then move 20 samples to

the right.

WK Display data as waveforms starting from sample x. x is

entered in sample number units. If Internal Clock is being
used, x may also be entered time division units.

WX,y Display data as waveforms from sample x to sample y.

WALL Display data as waveforms from first through last sample.

The form Wx will always cause 80 samples (less a few covered up by
the channel labels) to be displayed. The form Wx,y will always cause at

least 80 samples to be displayed, even if y-x is less than 80.

If y-x is greater than 80, samples from x to y will be be "time

compressed" to provide a "zoom lens" view of the data that is useful for

finding data patterns of interest quickly. However, this feature must

be used with care for the following reasons.
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With compression, the H1 or L0 level shown in each column on the

screen for a given channel may really be the algebraic sum of several

samples. For example, if y-x is equal to 240, then each of the 80 HI or

L0 levels shown for Channel 0 really represents three samples in the

data. If the three samples are all HI, then the screen will show a HI,
and fairly represent the data. On the other hand, if the three samples
have a mix of logic levels, then the logic level displayed will be based

on "majority rule."

The compressed display depicts the data most fairly when there are

few transitions in the data. If there are many closely spaced
transitions, detail is lost.

13.4 COMMAND EXAMPLES

W16 Display data as waveforms starting at sample 16.

W~500,500 Display "zoom" of data from samples —500 to 500.

W300ns Display data from the sample at 300 nanoseconds.

13.5 DISPLAY CONTROL KEYS

The highlighted cursor or the entire display may be scrolled right or

left using these keys:

< scroll the display horizontally one page to the left with an

overlap of 5 samples (75 samples displayed)

> scroll the display horizontally one page to the right with an

overlap of 5 samples (75 samples displayed)

<— move the highlighted cursor one sample to the left

-> move the highlighted cursor one sample to the right

These four keys auto—repeat; hold the key down for repeated scrolling
or cursor movement .

13.6 HELP PAGE

To display the Help Page for the W Command, type "?W<RETURN>".

Rev. D
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14. EDGE DISPLAY

14.1 INTRODUCTION

The Edge Mode Display is a compressed version of the Waveform

Display. It might also be called the Transition Display, because it
displays transitions only. Most repeated occurrences of the same

pattern are not displayed, thus showing samples only where the data is

changing. If three or more consecutive samples in all the channels to
be displayed remain in a steady state, the data will be removed and the

display will show a vertical blank where the steady state data was

removed.

Exhibit 14-1 is an example of the Edge Display as it appears on the
screen.

+—--+----+-—--+—~-"—+—'—-+----+----+—---+----+—--—+-—--+----+---—+----+‘---+---
-39 -23 -18 -13 2 25 EB EB 71 76 81 117 122 127 1? 168
7 EfidflBCCIFEdFEW 77 KdflBCClFEdFEW K4208CC1FE4FE77 K4KBCC1FE4FE77 KGBEBC
6 DESBIMIBBDFM 66 DZSBIWBBBDFB‘IIEIM£1%880F5%6 DESEIWBBDFBEEE. 0258183
U 33me 28 3377a7mm 337787mm 3377a7mam 3377377
B BWIENIE’MFB m emmmzaara am1e7a1234m Bm16781234F8 BEHIBI
his mum Dela);B [:2 SH refifl

?| Enter: C,D,E,F,G,H, I,L,M,H,0,P,S,T,H,X.Z,=,?,sp cumfl

Exhibit 14-1. Edge Display. The E Command causes data in the Sample or

Reference Memory to be displayed in this format.
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14.2 SCREEN CHARACTERISTICS

Explanations of the data appearing in the Edge Display are given
below.

Channel labels - left side of screen; default to the DF, DE ... D1,
D0 shown on the Trigger Menu and on the probes at power-on.

The labels shown here (DATA—7-, MREQ, etc.) are user-specified
labels which were entered with the N Command.

Waveforms - for active channels show the transitions versus time on

the displayed data lines. Time periods where no transitions

occur (i.e., 3 or more consecutive samples without a change
in any of the selected channels) are displayed as a single
blank column. The value of the data during the time period
represented by the blank column is the same as the data shown

in the column to the left of the blank.

Glitches - shown as narrow pulses on the waveforms if glitch

display is enabled and any glitches are present.

Highlighted cursor - marks a particular sample. Its location is

displayed to the right of "cur:. It is movable with the <-

and —> keys.

Graticule — located beneath traces; identifies the samples relative

to the trigger point. Calibrated in either sample or time

divisions (specify on Options Menu, 0 Command). Time

divisions are dependent on Sample Rate selection.

Hex codes - in vertical columns beneath the graticule; represent
the hexadecimal equivalents of the data above. The hex value

of the sample marked by the cursor is highlighted by increased

brightness.

Rate - indicates either the Sample Rate, when the Internal Clock is

being used, or External Clock, when an external source is

being used as the sample clock. When Internal Clock is used,

the Sample Rate is expressed in time units.

Delay - indicates the Delay (of sample 0 compared to the trigger
event), a data collection parameter specified on the Trigger
Menu.

Window - to the right of the Delay shows where the 80 samples

displayed lie in the total lOOO-sample memory.

SM or RM - to the right of the window indicate whether the data

being displayed is in the Sample Memory or the Reference

Memory.

<G or G) - if shown, mean there are glitches to the left or the

right of the cursor. <G> indicates glitches to both the right
and the left.
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ref: - indicates the sample that the X Command uses as a reference

point to measure from. The X Command is a utility that

calculates the interval, in number of samples and time, beween
two samples. See Section 16 for further information on the X
Command.

cur: - identifies the position of the highlighted sample cursor

relative to the trigger event (Sample 0). When the Internal
Clock is used, this part of the display also shows the time

interval between the sample marked by the cursor and the

trigger event.

? - at lower left is the home position of the prompt-cursor.
Commands entered by the user appear here.

Enter: — shows the commands which may be entered next. Press

<SPACE> or the "T" key to return to the Trigger Setup Menu.

14.3 COMMAND FORMATS

The Edge Display is controlled by the E Command using one of the

following command formats:

E Display data as compressed waveforms while centering the

sample marked by the highlighted cursor in the previous
display.

Ex Display data in Edge mode starting from sample x. x is

entered in sample number units. If Internal Clock is being
used, x may also be entered in time division units.

Ex,m Display data in Edge mode starting from sample x and

including only channels defined by m in the edge transition

algorithm.

14.4 COMMAND EXAMPLES

E16 Display data in Edge mode starting at sample 16.

E300ns Display data from the sample at 300 nanonseconds.

14.5 DISPLAY CONTROL KEYS

The highlighted cursor or the entire display may be scrolled right
or left using these keys:

< scroll the display horizontally one page to the left

> scroll the display horizontally one page to the right

<— move the highlighted cursor one sample to the left

-> move the highlighted cursor one sample to the right
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These four keys auto-repeat; hold the key down for repeated scrolling or

cursor movement.

14.6 HELP PAGE

To display the Help Page for the E Command, type "?E".
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15. NAME COMMAND

15.1 INTRODUCTION

N, the Name Command, changes the channel names that label the
traces in the Waveform Display, Edge Display, and Signature Analysis.
The Logic Analyzer initially shows labels DF, DE,...D0 for the standard
16 channels. If the 32 channel option is installed, labels AF, AE,...AO
appear for the additional 16 channels. If signals such as a read pulse,
write pulse, and two address lines are being probed, more descriptive
names such as READ, WRITE, ADDRO, and ADDRI make interpreting the data
much easier.

New labels installed with the N Command also appear automatically
on the Trigger Menu. On the Trigger Menu, the label for whichever
channel the cursor is on appears under "Signal" when you are entering
new parameters in Items 1 through 4.

15.2 COMMAND FORMAT

Use the N Command with the following format:

N#xyz Name channel # as xyz

# = channel indentifier F,E,..2,l,0

xyz =

any character string not over 15 characters long. Spaces are

not allowed in the string; use underscore or hyphen
characters instead.

14.3 EXAMPLE

NZMEM-READ Name Channel 2 with the label "HEM—READ". Each

Waveform, Edge, and Signature Analysis Display, as well as

the Trigger and Search Menus, will then contain this label
instead of the default label, "D2".

15.4 HELP PAGE

To display the Help Page for this command, type "?N".

Rev. D
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16. INTERVAL CALCULATIONS

16.1 INTRODUCTION

The X Command is a convenience feature that calculates the
interval, expressed in time or number of samples, between any two

samples. You provide the two end points of the interval, and the Omni
calculates the time (if Internal Clock is being used) and number of
samples between these points. The end points can be entered as

parameters with the command, or the highlighted cursor can be used to
mark them.

16.2 COMMAND FORMAT

The X Command can be used in one of these formats:

X Calculate the number of samples and time between the current

highlighted sample and the reference sample. The reference
sample is the sample marked with the cursor during the

previous use of the X command. If the X Command has not been
used since data was last collected, Sample 0 is the reference
Sample.

Xm Calculate the number of samples and time between the current

highlighted sample and sample m.

Xm,n Calculate the number of samples and time between samples m

and n.

16.3 EXAMPLES

X lOns Calculate the number of samples and time between the
current highlighted sample and the sample that occurred
10ns after trigger.

X 10,20 Calculate the number of samples and time between sample
number 10 and sample number 20.

These commands must be followed by a <RETURN> when they are entered. Do
not type the space between the "X" and the "10"; it appears
automatically. Note that when two parameters are specified, a comma is
required to separate them.
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Exhibit 16-1. Two uses of the Interval function (X Command).
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Assume that Internal Clock is being used with a Sample Rate of S

microseconds. Then the command "X 10,20" will result in this display at

the lower right corner of the screen:

Delta Time: 10/50.0us

Sample 10 and sample 20 are 10 samples apart, which is 50.0

microseconds, given 5 microseconds between samples.

It is possible to mix time and sample number units when using the X

Command. Assuming the same 5 microsecond Sample Rate, the command

X 10,125us<RETURN>

will give the output "IS/75.0us". Sample 10 corresponds to SOus, and

125us corresponds to sample 25.

In another format, assume the display cursor is at sample number

30. The command

X 10<RETURN>

will cause an output of "20/100.0us". Since only one parameter was

provided in the command, the cursor position (30) was used as the left

point of the interval and the 10 as the right point.

Let us assume that the cursor was positioned on the leading edge of

some waveform when the command "X 10" was given, and the cursor has

since been moved to the trailing edge of the same waveform at sample
number 65. The command

X<RETURN>

will calculate the interval of time between the cursor at last use of

the X Command (30), and the current cursor position (65). The output in

this case will be "35/155.0us". Using this technique of cursor

positioning in conjunction with the X Command, it is very easy to

measure time intervals for waveforms, parts of waveforms, or for time

between events. For waveform timing, the display will usually be Timing
or Edge. With the Dump Display, intervals between events may be

calculated by marking them with the cursor and using "X<RETURN>" twice.

Another powerful technique is to use the Locate function to

position the cursor on the events of interest, and the X Command to

calculate the interval between them. After the first occurrence of the

pattern has been found, issue "X<RETURN>" to establish the cursor

position as a point of reference. (Ignore the output of this first X

Command; we are only interested in establishing a reference for the next

use.) Then find the second event with the Locate function. Finally,
use "X<RETURN>" again to give you the number of samples and time between

the first and second events.
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16.4 HELP PAGE

The Help Page for the X Command may be obtained by typing "?X".
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17.). INTRODUCTION

l7. DUMP DISPLAY

This display, illustrated in Exhibit 17-1, shows the data in Sample
Memory as a listing in hexadecimal, binary, decimal, or octal format.

radix (base) of the display defaults to hexadecimal, but can be changed to

binary, decimal, or octal using the Options Menu, 0 Command.

The

AYE? 76m [11 7681

F683 76% 8878 7681

[584 76% C871 7681

763F 76% 851) 7681

7&8 75w (BEE 7681

76m 75m (68F 7681

7E8? 7688 [1928 7681

7&8 7% [[81 7E8]

7E£8 7688 4F8Z’ 7681

7E£8 7Em FEEC-i7E81
76E8 7628 [98d 7681

7E£8 7Em 7E821 7E81
76m 75m 7681 7681

7E£8 76m 7E81 7681
75m 76m 7681 7681
76m 76m 7E81 7E81
7H8 7628 7681 7681

7&8 E038 7E81 7681

7E88 [733 7681 7681

76E8 4576 7681 7681

7&8 E878 7E81 7681

7681 7681
7681 7681

7681 7681
E1138 7681

[2'39 7E81
457R 7681(7681
[878 7681
81% 7681
8178 7681

(871 7681

(8% 7681
1887 7681

F848 7681
[[81 7E81

4F82 7681

F683 7681

[581 7E81

7&8 7681

7E81 7681

7E81 7681

7681 7681

Rafe [XTERNRL Delay 8

7681
7611
7681

7681
7681

F883 7681
[984 7681
76% 7681
7681 7681
7681 7681

7681 7681

7681 7681

7681 7681
7681 7681 7681
ED}: 7681 7681
C239 7E81 7681
4578 7681 7681
[878 7E81 7681
[1185 7681 7681 7681
8178 7681 7681 7681
C871 7681 KISS 7681
[8% 7681 [239 7681
1887 7681 4578 7681
F848 7681 88FE: 7681

[[81 768] 8185 7681

C871

F848

[[81

7681

7681 [584

7681
7681

7681
7681

7681
68% 7681

1887 7681
7681

7681

4F8E' 7681
FE83 7681

7681

76% 7681
7681

7681

7E81
7681
7681

7681

7681

7681

7681

7681
7681

K138 7681
C239 7681

11576 7681
$78 7681
8185 7681

8178 7681

[.871 7681
(SEE 7681
1887 7681

F848 7681
[[81 7681

4F8Z’ 7681
FEB 7681
[584 7681
75m 7681

7681 7681
7681 7681
7681 7681
7681 7681

7681 7681
4F8Z' 7611 8178 7681 7681 7681 7681

[:1 CM

1 Enter: (,D,[,F,G,H, I.L,M.H,0.F',S,

Exhibit 17-1.

Reference Memory to be displayed in this format.

Dump Display.

ref28

7681
7681

7681

7681
7681
7681 7681
2036 7681
C239 7E81
4578 7681
8878 7681

DIE) 7E81
8178 7681
C871 7681

68% 7681
1887 7981
F848 7681
[[81 7E81
4F8Z‘ 7681

[£83 7681

[684 7681

7628 7681

7E81

7681

7681
7681
7681

T,N,X:Z,=,7,spamass

7681
7681
7681
7681
7681
7681
7681

7681
7681
7681

7681
7681

[[138
[239

4578

£878

DIES

8 178

8 178

8 178

8 178

The D Command causes data in the Sample or

Also, if the data last

displayed was in this format, new data collected in response to the G or

"=" Command will be displayed in this format.

"<" symbol next to the highlighted sample in the fifth column.
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The same data can be re-displayed in the new base after changing
the base; it is not necessary to collect a new sample. This flexibility
greatly eases interpretation of the data. For example, control lines

are usually best represented in binary, while data lines demand hex or

decimal.

Exhibit 17-2 shows the same data as 17—1, but Ice-displayed in

binary notation. The Omni automatically centers the display about

whichever sample was marked by the cursor in the previous display.

When the 32 channel option is used, the two banks (of 16 channels

each) can be simultaneously displayed with different number bases.

The Dump Display is normally used with External Clock to collect

state data.

81118118 am 1111

81118118 m 1111

81118118 am 1111

81118118 ma 1111

81118118 m 1111

81118118 m 1111

81118118 w 1111
81118118 m 1111

8111 8118 m 1111

8111 8118 m 1111
8111 8118 ma 1111

81118118 m 1111

8111 8118 m 1111

81118118 m 1111

81118118 mm 1111

8111 8118 m 1111

81118118 m 1111

81118118 w 1111

8111 8118 m 1111
8111 8118 m 1111
m 1181 $11 1818

8119 EXILE“ [blag

1188 M18 8811 1811
mm 8181 8111 1818
m was 8111 1811

1181 W1 m 8111

1M1111 8111 M18

1163 m 8111 le
11m 1% m 8118

m1 1% m 8111

1111 1% mm 1818
1118 1181 MB B11

was 1111 an M18

1111 1811 92m $11

1118 1&1 m 8118

81118118 am 1118

81118118 m 1111

8111 8118 m 1111

81118118 m 1111

81118118 52m 1111
8111 8118 m 1111

81118118 am 1111
81118118 m 1111

:l:151‘|

81118118 awe 1111

81118118 m 1111

81118118 am 1111

8111 8118 m 1111

81118118 am 1111

81118118 am 1111

81118118 22m 1111
81118118 m 1111

81118118 m 1111
8111 8118 am 1111

8111 8118 am 1111
81118118 am 1111
81118118 m 1111

81118118 MB 1111
8111 8118 w 1111
8111 8118 m 1111

81118118 m 1111

81118118 m 1111
81118118 m 1111

81118118 m 1111
81118118 m 1111

ref :8

?| En1er: C,D,E,F,G,H,I,L,11,H,0,P,S,T,IJ,X,Z,=,?,sp curl-5

Exhibit 17—2. Dump Display of the same data as in the last exhibit,
this time in binary format. The display is centered about the sample
marked by the cursor in whichever display appeared previously.
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17.2 SCREEN CHARACTERISTICS

Explanations for the data appearing in the Dump Display appear

below.

Rate — indicates either the Sample Rate, when the Internal Clock is

being used, or External Clock, when an external source is

being used as the sample clock. When Internal Clock is used,
the Sample Rate is expressed in time units.

Delay — indicates the Delay (of Sample 0 compared to the Trigger
Event), a data collection parameter specified on the Trigger
Menu.

Window diagram — to the right of the Delay; shows where the samples
displayed lie in the total IOOO-sample trace memory.

SM or RM - to the right of window; indicate whether the data being
displayed is in the Sample Memory or the Reference Memory.
Selected via the Options Menu, 0 Command.

(G or G> - if shown, mean that there are glitches to the left or

the right of the cursor. <G> indicates glitches to both the

right and the left.

ref: - indicates the sample used as a reference point by the X

Command, that is, the point from which an interval is

measured. The X Command is a utility that calculates the

interval, in number of samples and time, between two samples.
See Section 16 for further information.

Enter: - shows the commands which may be entered next.

cur: - indicates the current cursor position in sample number or

time units relative to the trigger event.

17.3 COMMAND FORMAT

The Dump Display is controlled by the D Command. Anytime the

current display menu does not contain a D option, the data in trace

memory may be displayed by using one of the following command formats:

Dx Display data in Dump format, starting from sample x.

D Display data in Dump format, centered on the current cursor

position.

17.4 EXAMPLE

D16 Display data in Dump format, starting at sample 16.
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17.5 DISPLAY CONTROL KEYS

The sample cursor is a highlighted "<" symbol. The sample marked
by the cursor is also highlighted by intensified brightness. The cursor

may be moved right, left, up, or down, or the entire display paged right
or left, using these keys:

< scroll the display horizontally one page to the left.

> scroll the display horizontally one page to the right.

<— move the cursor one column to the left.

—> move the cursor one column to the right.

T move the cursor up one sample.

l move the cursor down one sample.

17.6 HELP PAGE

To obtain the Help Page for the D Command, type "?D".

Rev. D
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PLEASE NOTE

Version 7-30—86 of the Logic Analyzer Program, and earlier

versions, have the following differences from the manual:

1- For the Locate function, the command "G" (not <TAB> as the

manual states) is used to initiate a search of sample memory. "G" does

not cause a new data collection when used in connection with the Locate

Menu.

2. For the Correlation function, the command "G" (not <TAB>) is

used to start the correlation process. It does not cause a new data

collection when used in connection with the Correlation Menu.

3- To use the Print function, use the command "P", not CTRL-P

(control P).

The manual text anticipates an updated version of the software

which is in preparation and will be sent to you when it is complete.

Thank you.

OnniLogic, Inc.





18. CORRELATION

18.1 INTRODUCTION

The Omni has a Sample Memory and a Reference Memory. The Reference

Memory is normally used to hold data collected previously, for purposes

of comparison with the data most recently collected.

The Correlation function makes the comparisons between data in the

Sample and the Reference Memory. You can also use this function to

define a scenario which data collection will be repeated until

correlation with Reference Memory is attained; or until the sample data

being collected fails to correlate with the reference data.

The Correlation function is controlled by the Correlation Menu,
which appears in response to the C Command. Exhibit 18-1 shows an

example of the Correlation Menu and of the resulting Correlation

Display. Note that non-correlating samples are marked with a "<=>"

symbol and highlighted.

This function is very effective for finding discrepancies between

performance of a digital system under test (Sample) and a known good
system (Reference).

In the simplest mode of operation, the <TAB> key (in conjunction
with the Correlation Menu) causes correlation to be performed between

the data in Sample and Reference Memories. It does not cause new data

to be collected. Repeated use of the <TAB> key while viewing the

Correlation Menu merely repeats the exercise of the correlation

algorithm.

Correlation may be performed on the data in two disk files by
following this procedure: first, call up the File Menu (F Command) and

load one file into the Sample Memory using Item 4 or 5. Second, load

the other file into Reference Memory using Item 3. Third, call up the

Correlation Menu (C Command) and enter the desired correlation

parameters on the menu. Next, press <TAB> to cause correlation to be

performed. The result will be immediately displayed in a form similar

to Exhibit 18-1(b).

18.2 CORRELATION MENU

Eight parameters are used to set the conditions for making
correlations. The Correlation function has a number of modes that make

it very flexible.

Item 1) File to correlate with:

The data in Reference Memory is loaded from a file on the disk.

The file was created previously when data from a prior collection cycle
was saved from the Sample Memory onto the disk, using the File

Operations Menu.
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(b)

Exhibit 18—1. Correlation Menu (3) and resulting display (b).
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To retrieve the prior data from disk and load it into the Reference

Memory, enter the filename in this item and press the return key.
Alternatively, the file may be loaded to the Reference Memory using the

File Menu (F Command). If the file is not on the disk, a disk I/O error

message will appear. Recovery from the error is automatic; the input
prompt will reappear at the lower left corner of the screen.

Item 2) Channel mask:

Channels which do not contain meaningful data and are to be ignored
in the correlation can be "masked out" by entering a Channel Mask

specification in Item 2. Enter a "l" to indicate channels to be

included in the correlation. Enter an "X" to indicate channels to be

excluded. If a "O" is entered, it will have the same effect as a "1".

The cursor control keys -> and <— can be used to move the prompt-cursor
without affecting a channel specification. Direct positioning of the

prompt-cursor to Channels F through 2 can be accomplished by entering
the channel number. Press <RETURN> or <SPACE> to leave this item.

Item 3) First sample included:

Item 3 allows you to specify the first sample at which the

correlation process is to begin. Samples before the specified first

sample are ignored by the correlation algorithm. The number entered

here refers to the sample number in Reference Memory. The default entry
for this item is Sample 0.

Item 4) Number of Samples:

This item is used in conjunction with Item 3 to limit the range of

samples over which correlation is performed. The correlation algorithm
will stop after processing the number of samples specified in this item.

Item 5) Starting point skew allowance:

Due to sampling differences, comparable patterns in the Sample and

Reference Memory may not start at the same sample number. The

difference is called "skew." The correlation algorithm allows for this

skew. Item 5 may be used to specify the maximum allowable skew. For

example, a value of 10 for the starting point and 4 for the skew would

mean that starting point of the matching data in the Reference Memory
could be anywhere from 6 to 14.

Item 6) Skew alignment samples:

The correlation skew algorithm begins comparing the data at a trial

skew value, and if match is achieved over the number of samples
specified in Item 6, it assumes that the trial skew value is correct.

It then completes the comparison process and displays the result. If

the correlation skew algorithm cannot locate a sequence of samples that

match exactly for the specified skew alignment samples (and with a

starting skew anywhere in the Item 5 skew allowance), then the

correlation is aborted. If such is the case, an appropriate message is

displayed.
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Selection C also activates a repeat data collection mode. When you
issue the G or "=" Command, the Omni likewise collects data to fill the

Sample Memory, and then tests for correlation with the data in the

Reference Memory. However, in this case, it continues to repeat the

collect and correlate cycle so long as correlation is achieved; when

correlation fails, it stops and displays the result.

Note that data is not being collected during the part of the cycle
in which the Omni is testing for correlation in the data.

18.3 HELP PAGE

A Help Page for the Correlation Menu may be obtained by typing
"?C". When viewing the menu, you can access Help Pages for Items 1, 2,
etc., by typing "?l", "?2", etc. After seeing the help information,
press <SPACE> to return to the Correlation Menu itself.

Rev. D
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l9. MATRIX DISPLAY

19.1 INTRODUCTION

This display, illustrated in Exhibit 19—1, is a table showing the

number of times a specific bit pattern has occurred within a given range

of samples. The maximum pattern length is eight bits. The display uses

the lowest eight active channels according to the Trigger Menu, T

Command.

Chunnels7654/3218 nge-Smfo499
5 6 7 B 9

B
1

2

3
4

5

Eu
7

B

'3
n

B

C

D

E

F

Enter: C,D,E,F,G,H,I,|.,M,N,0,P,S,T,H,X,Z,=,?,sp

Exhibit 19-1. Matrix Display.

Omni Operating Manual 19-1 Matrix Display



19.2 DISPLAY CHARACTERISTICS

There are 256 possible bytes, that is, 256 possible different

combinations of 8 bits. The body of the table shows the number of times

each of the 256 different combinations occurs in the specified range of

samples.

A byte is represented in hexadecimal notation by two digits, e.g.
"7B". The scale 0 — F on the left lists the first hex digit of the

byte, and the scale across the top lists the second. Thus to find the

number of occurences of the byte "7B", find II7" on the left side scale,
then read across to column "B". The example in Exhibit 19-1 shows that
7BH occurs 20 times.

The other features of the display are:

Channels - at the upper left; lists the eight (or less) channels

that were surveyed in creating the display.

Range - at the upper right; gives the range of samples over which

the count was made. In the example, the byte 73H occurs 20

times between sample -500 and sample 499, inclusively. The

range is specified in the parameters x and y used with the M

Command.

Enter: - at the bottom; indicates the commands which are available
DOW.

19.3 COMMAND FORMATS

The Matrix Diagram Display is controlled by the M Command by using
one of the following command formats:

M display matrix of data shown in previous display, starting
from the same sample as the previous display. The number of

samples shown will be the same as in the previous matrix.

Mx display matrix of data for the same number of samples as the

previous matrix, starting from sample x.

Mx,y display matrix of data in Sample Memory from sample x to

sample y, inclusively.

MALL display matrix for entire Sample Memory.

The parameters x and y may be expressed as sample numbers. If

Internal Clock is being used, they may be expressed either as sample
numbers or as time units. When the Matrix Display is first used after

turn-on, the default value for the number of samples over which the
matrix is calculated is 80 samples; in other words, y is assumed equal
to x+79 if it is not specified.
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19.4 EXAMPLES

M16,64 display data between samples 16 and 64, inclusively.

M40ms display data starting at the sample 40 milliseconds after
trigger, for the same number of samples as the previous
display.

19.5 DISPLAY CONTROL KEYS

The "<" and ">" keys allow you to shift the range of samples over
which the matrix is formed.

< display matrix ranging over the same number of samples as the
current matrix, but just before the current matrix.

> display matrix ranging over the same number of samples as the
current matrix, but just following the current matrix.

For example, assume that the current matrix is a summary over

samples 40 through 79. Striking the "<" key causes a matrix for samples0 through 39 to appear (after a short delay). The ">" key causes a
matrix for samples 80 through 119 to appear.

19-6 HELP PAGE

To display the Help Page for the M Command, type "?M".

Rev. D
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PLEASE NOTE

Version 7-30~84 of the Logic Analyzer Program, and earlier

versions, have the following differences from the manual:

1. For the Locate function, the command “G" (not (TAB) as the

manual states) is used to initiate a search of sample memory. "C" does

not cause a new data collection when used in connection with the Locate

Menu.

2. For the Correlation function, the command "G" (not <TAB>) is

used to start the correlation process. It does not cause a new data

collection when used in connection with the Correlation Menu.

3. To use the Print function, use the command "P", not CTRL—P

(control P).

The manual text anticipates an updated version of the software

which is in preparation and will be sent to yOu when it is complete.

Thank you.

GmniLogic, Inc.





20. LOCATE

20.1 INTRODUCTION

Locate is a utility feature which finds a data pattern in the

sampled data. It is used after data collection has occurred, and is

independent of the Trigger Event and other trigger conditions used to

specify the collection of data.

Exhibit 20-1 shows two examples of the Locate Menu, in which the

search parameters are entered. Exhibit 20-2 shows the appearance of the

Waveform Display after a desired sample pattern has been found and

highlighted using the Locate function. Note that the cursor is on the

sample containing "FCSZ", the first word of the Search Pattern specified
in Exhibit 20-l(a).

20.2 LOCATE MENU

Enter "L" to bring up the Locate Menu. To change any aspect of the

menu, enter the desired item number and change the parameter.

The first three items are used to set up conditions for the search.

Item 1, Start Sample Number, indicates the sample number at which to

begin the search. Item 2, Input Mode, specifies the number base for the

subsequent items. Item 3, Global Channel Mask, is used to select the

bits that will be used during the pattern search. Bits that are to be

included in the search are indicated by a "l". Bits that are to be

ignored are entered as a "0". The default conditions for these first
three items are adequate for most searches.

The data pattern to be found is entered in Items 4 through 9, the

Search Pattern. The pattern is a sequence of digital words which must

be matched by a corresponding consecutive sequence of data samples in

the Sample Memory. The search starts at the Start Sample Number and

proceeds through the Sample Memory until the first complete match is

found, or if there is no complete match, until it reaches the end of

Sample Memory.

After entering the first word of the pattern in Item 4, press
<RETURN> and the prompt-cursor will move to Item 5, ready to receive the

second word. When you have entered as many words as your search pattern
requires (often only one), press <SPACE> to leave the Search Pattern

items.

20.3 MAKING THE SEARCH

When all changes to the menu have been entered, press the <TAB> key
to initiate the pattern search. If the pattern is found, the Omni will

return to a data display with the found pattern highlighted. If the

pattern is not found, "Not Found" will appear in the upper right corner

of the Locate Menu.
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1) Slarl Sample Nunber 489

2) lnpul l’nde HEX

3) Global Olannel l‘lask FFFF

4) Search Pallern FCSZ

5)
6)
7)
8)
9]

Index 1-9, 6 To search, P, 7, or (space)

1) Start Sanple Number 4152

lenpu’ll‘bde BIN-RY

FEDCBR‘3876543216

3) Global Ouannel Mask

4) Search Pal lern

5)
6]
7)
8)
9)

Index 1-9, 6 to search, P, 7, or (space)

(b)

Exhibit 20-1. Locate Menu. (3) Example of entries in hexadecimal format.

(b) Example of entries in binary format, which allcws "don’t care" ("X")

specification of individual channels in the search pattern.
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1 Enter: C,D,E,F,G,H,I,L,M,H,0,P,S,T,IJ,X,Z,‘,?,spcum-466

Exhibit 20—2. Waveform Display of the sample pattern "FCSZ" found

using the Locate function.

Note that the <TAB> key does not cause the Omni to collect new

data. It merely initiates a search through the existing data in Sample

Memory.

Each time a search pattern is found, the Start Sample Number on the

menu will be updated automatically to start the next search at the

sample after where the pattern was last found. Once a search pattern

has been entered, it is possible to find the second, third, and all

subsequent occurrences of that pattern by repeatedly typing (TAB) to

resume the search.

20.4 MENU ITEMS

More details about the individual menu items follow.
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Item 1) Start Sample Number

A pattern search can begin at any sample within the 1000 sample
trace. The sample can be specified either by a sample number, or if the

Internal Clock is used, by a time value such as SOus or -1000ns. All

sample number and time references are made with respect to the trigger
event. Sample number 0 and time 0 normally correspond to the point at

which the trigger event occurred. (If the Delay parameter, Item 8 on

the Trigger Menu, is non—zero, then Sample 0 will be delayed relative to

the trigger event by the Delay value chosen.)

When a starting sample number is selected, all samples before the

starting sample are ignored when executing a pattern search.

Item 2) Input Mode

This item is used to select the most convenient number base for

specifying the Channel Mask and Search Pattern. The default is

hexadecimal. For binary, decimal, octal, or unsigned decimal, enter

"B", "D", "O", or "U", respectively. "H" restores hexadecimal. When the

Input Mode is changed, all lines following are automatically updated to

reflect the new input number base.

Item 3) Global Channel Mask

Quite often a pattern search does not include all sixteen data

channels. Through the use of the Global Pattern Mask, the unused

channels can be ignored (made "don"t cares") during the search. A "1"

indicates a channel that will be considered in the search. A "0" means

"don't care", a channel that will be ignored in the search.

The Global Pattern Mask entry will usually be in a number base

other than binary, such as hexadecimal. In that case, the pattern of

"l"'s and "0"’s just mentioned refers to the binary form of the number

(as is always the case when a number is used to describe digital
signals).

When the Search Pattern is specified in a number base other than

binary, the Global Pattern Mask is the only way to indicate specific
"don’t care" channels. When the Input Mode is binary, as an alternative

each "don't care" channel can be indicated with an "X" in the Search

Pattern.

Items 4) thru 9) Search Pattern

The Search Pattern can consist of one to six consecutive sixteen

bit words. The search is considered successful only if a consecutive

sequence of samples is found in the Sample Memory that matches the

pattern word for word. "Don't care" patterns are indicated by a blank

line, and are entered by pressing <RETURN> to skip over the line. When

in binary mode, a "don’t care" pattern can be entered with an "X" on

every channel. Upon completion of the pattern entry, press <SPACE> to

exit this item.
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20.5 EXAMPLES

The first example involves monitoring the instruction sequence on a

microprocessor’s eight-bit data bus. Consider the menu entries:

1) Start Sample Number 50

2) Input Mode HEX

3) Global Channel Mask FFOO

4) Pattern C300

5) 5500

6) 2300

7)
8)
9)

Here the channels of interest are the upper 8 (i.e., Channels F

through 8). This is indicated by eight high level bits ("FF") in the

top (leftmost) position of the Global Channel Mask. The lower eight
bits of the Global Channel Mask are set to "O" to establish a "don’t
care” condition on the low channels.

The pattern is the sequence "C3", "55", and "23". (I.e., a jump to

location 2355 on a 280 micrOprocessor. The "55" comes before the "23"
because the 280 fetches the low byte first.) To maintain positional
integrity, each of these three entries was filled to the right with
"00". (Any eight—bit fill would provide the same result because the
Channel Mask forces these bits to be "don’t cares" during the search.)
Because the start sample number is 50, any occurrences of the three

sample sequence before sample number 50 are ignored.

The second example illustrates the same application scenario,
however the Search is generalized to require a match on any jump to a

23XX address. The menu entries for this case are:

1) Start Sample Number 50

2) Input Mode BINARY

3) Global Channel Mask 1 1 1 1 l l 1 1 X X X X X X X X

4) Pattern 1 l O 0 0 0 1 1 X X X X X X X X

5) X X X X X X X X X X X X X X X X

6) 0 O 1 O 0 0 1 1 X X X X X X X X

7)
8)
9)

Since the input mode is binary, additional qualification of the

pattern is possible. The Global Channel Mask specification forces the
use of only the high eight bits in the search. The second sample in the

pattern is specified as a "don’t care", and hence will always match the
data collected following the "C3". The search will be successful on any
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three sample sequence where the first sample is "C3", the third is "23"

and the second can be any pattern;

20.6 HELP PAGE

A Help Page for the Locate Menu may be accessed with "?L". When

viewing the menu itself, you can access Help Pages for the individual

Items 1, 2, etc., by typing "71", "?2", etc. Press <SPACE> to return to

the Locate Menu from the Help Pages.

Rev. D
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21. FILE OPERATIONS

21.1 INTRODUCTION

File operations allow you to:

0 store and retrieve sample data and test parameters to and from

disk files.

0 display a directory of the files stored on disk.

0 delete data files.

0 move data from Sample Memory to Reference Memory.

0 retrieve tables of instruction mnemonics for different

microprocessors for the Instruction Disassembly function.

0 record keystrokes in a log file, and later re-execute them

automatically.

These functions are controlled by the File Menu, which appears in

response to the F Command. Exhibit 21—1 shows the File Menu as it

appears when first called up.

21.2 MENU ITEMS

Explanations of the individual menu items follow.

Item 1) Title:

The title is an optional input of up to 40 characters which will
label any individual data or setup parameter file saved on disk. When
this stored data is retrieved, the title is also displayed. The use of

a title is a convenient way to describe the characteristics of the

recorded data file for positive identification at a later time.

NOTE: Spaces are not allowed in the title. Use the underscore

character or hyphen instead.

Item 2) READ instruction MMEMONICS from file:

Instruction disassembly is performed by matching collected data
with a predefined file of instruction mnemonics. Some mnemonics have

already been defined and recorded on disk under files bearing the name

of the processor and the file extension “.LAM". When specifying the

filename in Item 2, enter only the name of the file; the extension is

appended automatically.
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7] RITE all data 8 paraneiers onto fi le:
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Col led ion dates: Sanple Reference

$47434 16:42: 15 5/37/84 16:39:18

[Mar 1- B, ? for help, or WE fa exi1

Exhibit 21—1. File Menu. The 280 mnemonics file, which is used for

Instruction Disassembly, appears by default in Item 2.

Item 3) READ into REFERENCE memory from file:

After sample data has been collected and saved on disk, it can be

returned to either Sample or Reference Memory. Moving stored data into

Reference Memory allows it to be displayed just like data in Sample

Memory, or it can be used for Correlation operations. Data is read from

disk into Reference Memory when the filename is entered in this item and

the <RETURN> key pressed. Do not enter an extension; the extension

".LAD" is appended automatically.

NOTE: The preceding function will not provide Reference Signatures for

signature analysis. They must be read in using Item 7 on the Signature
Menu. See Section 24, Signature Analysis.

Item 4) READ into SAMPLE memory from file:

To transfer data from a disk file to the Sample Memory, enter the

filename (without the extension) in this item. The data will be

restored in its raw format and will not contain any characteristics such

as channel labels, Sample Rates, or trigger conditions. When the

retrieved data is displayed, the time scale and other collection
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parameters on the screen may not correspond to the data, and a warning
message to that effect will be displayed.

The Omni records date and time when sample data is collected. This

time record is saved with a stored file, and returned when the file is

returned.

Item 5) READ all data & parameters from file:

This item retrieves data and parameters that were saved using Item

7. Upon retrieval of the data and parameters, the analyzer setup
conditions (trigger word, display number base, etc.) are totally
reconfigured from their current state to the setup conditions that were

saved on disk. Use of this option is a convenient way to restore a

given setup state from a power-up condition.

NOTE: All the parameter settings currently in effect will be lost when

this function is used, since it replaces them with the parameters stored

on disk. This includes changing the data in Reference Memory, if File

Menu Item 3 had a filename in it when the analyzer state was originally
stored via Item 7.

CAUTION: Data files saved using earlier versions of the Logic Analyzer
Program should not be recalled using this item. In order to expand
capabilities, it was necessary to modify the parameter storage formats.
As a result, attempting to recall data that was saved using an early
program version (prior to 4-1—84) may cause problems.

Item 6) WRITE SAMPLE memory onto file:

After data collection has been made, the data can be saved to a

disk file by entering the filename in this item. Filenames can contain

up to eight alphanumeric characters and an optional disk drive specifier
in the standard format:

d:ffffffff

where d is the drive specifier ("A" or "B") and ffffffff is the
filename. Do not enter an extension; all files saved will be

automatically assigned the extension ".LAD".

If the disk drive specifier is omitted, the specifier for the

default drive (often called the logged in drive) will be supplied
automatically. If a drive other than the current default drive is

specified, then the specified drive will become the new default drive.
The default drive is displayed on the File Menu in Item 8.

Item 7) WRITE ALL data & parameters onto file:

Item 7 allows you to save not only the data, but also the setup
conditions of the analyzer. Channel labels, trigger conditions, Sample
Rates, and display parameters (the total state of the machine) are all
saved to disk. The former setup conditions (the entire state) are

restored through the use of Item 5. Enter the filename as in Item 6.
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Item 8) Display DIRECTORY of save files on drive: A

It is difficult to remember all the file names that have been saved

on a particular disk. To display a list of the logic analyzer files

resident on a given disk, select this item and enter the drive letter

("A" or "3") of the desired drive.

Press any key other than <SPACE> to see a display of all the files

on the disk. After viewing the directory, press <SPACE> to return to

the File Menu.

Item 9) DELETE data file:

Enter the name of a file (less the extension) in this item to

delete it from the disk.

Item A) COPY from SAMPLE into REFERENCE memory:

Accessing this item causes data to be copied from the Sample Memory

to the Reference Memory. Typically, a new sample collection will then

be made for comparison to the previous data. The Correlation function,

for example, correlates data in Sample Memory against data in Reference

Memory.

Item B) Log file status:

This item is used to make a log of your keystrokes which is saved

in a disk file. The keystroke sequence may be recalled and

automatically re-executed at a later time.

To create a log file, type "B" to access this item. Then enter "W"

for "write to log file." Enter the filename (less the extension) when

prompted for it. After the filename is entered, all keystrokes will be

recorded automatically.

To end the logging of keystrokes, type "B" to access this item

again. The Log file status will be immediately changed back to

Inactive.

To re-execute the recorded keystrokes, access this item and type

"R", for "read from log file", when prompted. Then enter the filename

of the desired log file. After you have entered the filename, the Omni

will fetch the file and re-execute the keystroke sequence it contains as

you watch. When it reaches the end of the file, the Log file status

will be reset to Inactive.

21.3 HELP PAGE

A Help Page for the File Menu may be accessed by typing "7F". When

viewing the Menu, you can obtain Help Pages for the individual Items L

2, etc., by typing "?1", "?2", and so on. After viewing a Help Page,

press <SPACE> to return to the File Menu itself.

Rev. D
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22. INSTRUCTION DISASSEMBLY

22.1 INTRODUCTION

A microprocessor executes its program by fetching instructions and
data from memory. The instructions are made up of two parts, opcodes
and operands. They appear as bit patterns on the data bus when the

microprocessor reads them from memory.

The Instruction Disassembly function allows you to trace program
flow by collecting this data bus activity and translating the bit

patterns back into instruction mnemonics.

To effectively utilize this mode of display, a very controlled data
collection procedure must be observed. This requires coordination
between the selection of channels, mnemonic definitions in a disk file,
and selection of an appropriate External Clock source.

The disassembler operates on the data in eight channels,
corresponding to the data bus of eight-bit microprocessors. The

optional 32 Channel Adapter, which extends the Omni's data collection

capability to 32 channels total, makes possible collection of complete
data and address activity.

Use of the Omni's internal clock is not appropriate for instruction

disassembly, since it is not synchronized with the data on the

microprocessor's data bus. The data bus is time shared, and valid data
is present only while certain control lines are valid. Use one of these
control lines as the External Clock signal to record data into the logic
analyzer’s memory, for example the "MEMORY READ" control line. Be aware

of the polarity of the control signal selected for use as the External
Clock. The Omni collects data on the edge of the External Clock signal.

Once the setup requirements and precautions have been observed, and
valid data collected, displaying the information in instruction format
is easy. The I Command initiates instruction disassembly.

NOTE: The I Command does not cause a new sample to be collected;
it merely translates the data already in Sample Memory into mnemonics.

22.2 DISPLAY FORMAT

After disassembly, the data is displayed as both bit patterns and
mnemonics in a format similar to that obtained from an assembler

listing. Exhibit 22-1 shows an example of the Instruction Disassembly
display.

The display is made up of several columns of data. The left column
is the sample number ("—465" in the first line in Exhibit 22-1). The
middle columns are the collected data ("OOOOllll-CB" in the exhibit).
The right column shows the collected data translated into mnemonics

("BIT 0,(HL)").
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Exhibit 22-1. Instruction Disassembly Display. The I Command causes

data in the Sample Memory to be displayed as instruction mnemonics.

The collected data "OOOOllll—CB" is displayed in this format:

bbbbbbbb—hh

/ \
/ \

/ \
8 binary 2 hex

digits digits

The 8 bits bbbbbbbb represent the signals on Omni Channels 7-0, some of

which are connected to the microprocessor control lines. The two hex

digits represent the data collected on Omni Channels F—8, which are

connected to the microprocessor data bus.
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Each line of the display corresponds to one instruction of
disassembled code. Each line will have either one or two of the
bbbbbbbb-hh patterns, depending on whether the instruction is a one-byte
or multibyte instruction. For instructions longer than two bytes, the
bbbbbbbb—hh patterns show only the first two bytes.

The representation of the Channel 7—0 control bits (bbbbbbbb) is
always in binary. The number base for the Channel F-8 data bytes (hh)is dictated by the Options Menu, reached by the 0 Command. The default
output base is hexadecimal. Refer to the Options Menu section for the
procedure to change the output base.

As well as mnemonics, the last column also shows any bytes which
are read by the microprocessor when it executes the instruction. For
example, look at the instruction starting at Sample -448. The
instruction "RET" is a single-byte instruction; "C9" is the opcode.To execute the instruction, the microprocessor read bytes "CF" and "04"
from memory.

Thus the last column shows all data bus activity - both the
reading of the instruction and its execution.

As with the other display formats, the cursor keys can be used to
move the highlighted cursor up or down, or scroll the entire display.

22.3 HOW g WORKS

During program execution, not only instructions appear on the data
bus; data read from memory and (in the case of processors using memory—
mapped I/O) input data appear as well. The disassembler must be able to
distinguish the opcode bytes from all the others in order to disassemble
the code correctly. There are three ways to do this:

Use the status lines — some processors provide status signals that
identify the opcode fetches. The 280’s /MREQ and /M1 signalsdo this, and the Omni's built-in 280 disassembler uses them.
The 8085 and 8080 provide status signals /IOM, SO, and 51,
which the Omni uses.

Start from a known opcode - if status signals are not available, a
non—status disassembler will work properly if it is started on
an opcode. The Omni's other disassemblers work this way. You
should start disassembly from an opcode byte with the command
"I n", where sample n contains an opcode.

Start anywhere — if a disassembler of the second type is started on
a byte which is not an opcode, the disassembler will
erroneously interpret it as an opcode and display incorrect
instructions. However, after a few lines of disassembly, it
will strike an opcode, get "in sync", and disassemble
correctly from there on.

The Omni actually contains two disassemblers: a status signal typedisassembler with built-in mnemonics for the 280 and 8085, and a table
driven disassembler that reads in the mnemonics from a file and can be
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used with any processor. The two disassemblers work somewhat

differently, so they will be described separately.

22.4 280 INSTRUCTION DISASSEMBLY

The Z80 Disassembly is the default choice — it is activated when

you first use the I Command. Reading a mnemonic file via the File Menu

is not required.

To perform disassembly for a 280 microprocessor, first connect

Channels F—S of the Omni to the 280 data lines D7-D0 respectively.

Note: The symbols "D7", ”D6", and so on are used for two different

applications - Omni probe lines and microprocessor data bus signals. To

avoid confusion here, we will refer to the Omni input lines as "Channel

F", "Channel 7", and so on. In this section of the manual, "D7", "D6",

etc. are used only to refer to the microprocessor data bus.

Connect /MREQ and /M1 to Omni Channels 6 and 7, respectively.
These are the two lines that are recorded to distinguish opcode fetches

from other bus activity. Attach the Clock probe lead to the

microprocessor system /RD line.

Set up the desired data collection parameters on the Trigger Menu.

Use the External Clock option and clock on the positive edge. Use the

Latched Mode.
»

RD

:D>—— EXTERNAL CLOCK — SELECTED

WR POSTIVE EDGE (1)

74L808

(A)

RD

:D—i EXTERNAL CLOCK - SELECTED

wa NEGATIVE EDGE (0)

74Lsoo

(B)

Exhibit 22-2. Circuits to combine /RD and /WR microprocessor strobe

signals into a single External Clock pulse. This allows both read and

write bus cycles to be recorded, and thus appear in the Instruction
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After all desired trigger parameters are set up and data has been

collected, enter the command "I<RETURN>" to perform instruction

disassembly. A display similar to Exhibit 22-1 will appear. Move the

cursor by using the up and down arrow keys, and step pages by using the

"<" and ">" keys.

The six channels not connected yet, Channels 5 through 0, will also

be displayed in binary form in the second column, along with Channels 7

and 6. They may be used to monitor any other signals you wish, such as

address lines or bits of I/O ports. Remember, a maximum of two bus

cycles per opcode fetch will be displayed for these lines. The Dump

display may be used to observe any bus cycles for Channels 7-0 not shown

by the Instruction Disassembly display, although this is rarely

required.

If it is required that data from write and output cycles be

recorded in disassembly, then an external gate will be required to

logically-0R the /RD and /WR lines to the External Clock input. Exhibit

22-2 on the previous page shows two possible circuits to accomplish
this.

22.5 8085/8080 DISASSEMBLY

Mnemonics for the 8085/8080 family microprocessors are also

available. The 8085 is a single-chip improved version of the 8080. It

runs the same software, except that it has two added instructions the

8080 does not have. The status signals are the same, /IOM, SO, and SI.

To activate the 8085/8080 mnemonics, enter 8085 in Item 2 on the

File Menu. Note that no mnemonics files for these processors will

appear in the disk directory - like the Z80 mnemonics, they are built

into the disassembler.

Connect Channels F-B of the Omni to the microprocessor's data lines

7 through 0, respectively. The latter are labeled AD7-ADO on 8085 and

8080 chip set diagrams. Connect Channel 7 to microprocessor status line

/IOM, Channel 6 to status line SO, and Channel 5 to status line Si.

From this point, proceed as recommended above for the 280.

22.6 FILE DRIVEN DISASSEMBLER

The file—driven disassembler does not require status signals from

the microprocessor. It finds opcodes by the "start from a known opcode"
or "start anywhere" methods.

To load the mnemonics for a given microprocessor, first call up the

File Menu with the F Command. Enter the name of the file containing the

mnemonics for the processor you wish to use in Item 2, Read Instruction

Mnemonics From File. Mnemonic files are stored on disk with the file

extension ".LAM". (Do not type the extension; ".LAM" will be appended
to the file name automatically.)
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After the data has been collected, use the I Command to initiate
disassembly. If you know that sample n contains an opcode, you can type"In<RETURN>" and disassembly will be correct starting from sample n.

Often, however, you will not initially know which samples contain
opcodes. In that case, the first few lines of disassembled code will be
incorrect.

22.7 8048 SERIES FILE DRIVEN DISASSEMBLY

The following briefly explains how to perform instruction
disassembly for the 8048 Series microcomputers (8048, 8748, 8039, 8035,
8OC48, etc.). A general knowledge of this family of microcomputers is
assumed. The file-driven disassembler is used with this series.

A special requirement of 8048 Series disassembly is that the
microcomputer be executing its program from external ROM, since this is
the only time opcodes are present on the data bus and can be captured.
PSEN (pin 9) will be usedrto strobe the data in, so connect this line to
the Omni's External Clock (positive edge). Connect the 8 data lines
from the microcomputer chip (pins 12—19) to Channels F—B on the Omni.

Set up the trigger conditions as needed. The mnemonics file for
the 8048 series is stored on the Logic Analyzer disk under the name

8048FAM.LAM. Load it using Item 2 on the File Menu. At this point data
can be collected and the I Command can be used to disassemble the code.

The lower 8 channels (Channels 7—0) are not required for
disassembly and may all be used for other functions, such as monitoring
addresses or bits from I/O ports. These channels are displayed in binary
form.

As was noted above, this approach is based on a method of

collecting data only when PSEN is active. The mnemonics table in the
file 8048.FAM is constructed for this method, and if you wish to use a
different approach, you will need to change the table.

22.8 CREATING MNEMONICS FILES FOR OTHER PROCESSORS

You can disassemble code for any processor or state sequencer by
putting a table of the corresponding mnemonics in a file on disk.
Exhibit 22-3 specifies the construction of the table. This makes it
possible to add instruction disassembly capability for new processors -

it is only necessary to construct a new table.

The first two bytes in the file represent the size of the table
(including the first two bytes). Next follow 256 packets, one for each
of the 256 possible one-byte opcodes. Unused opcodes must also be
represented in the file, with the mnemonic "??" (two question marks)
assigned to them.

The lead byte in the first packet (labeled "byte 2" in Exhibit 22-
3) is a binary number that equals the number of bytes in the packet
(including the first byte). The next byte ("byte 3") is a binary number
representing the number of bytes in the instruction fetch for the
instruction; this is normally one. The next byte ("byte 4") is the
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number of bytes of operand fetch and additional bus cycles that the

processor executes for the instruction. The next byte ("byte 5") is the

opcode, that is, the machine code binary number. The remaining bytes in

the packet ("bytes 6, 7, ... n") are the ASCII codes for the instruction

mnemonic.

Subsequent packets are constructed the same way. Note that the

packets are of varying length, depending on the number of bytes
(characters) in the mnemonic. The next packet follows immediately after

the end of the prior packet; there is no delimiter between packets. The

disassembler subroutine uses the first byte of each packet to tell where

the next packet starts.

DESCRIPTION OF MNEMONICS TABLE

byte 0,1 = size of table (unused by online disassembly)

PACKET DESCRIPTION

byte 2 = number of bytes in packet
byte 3 = number of bytes of instruction fetch

byte 4 = number of bytes of operands fetch and additional

bus cycles
byte 5 = opcode
byte 6,7,...,m = ASCII for instruction mnemonic

NEXT PACKET DESCRIPTION

byte m+1 = number of bytes to describe 2nd packet
etc.

TERMINATOR BYTE DESCRIPTION

byte n = 0 to signal end of table

DESCRIPTION OF PACKET FOR UNDEFINED OPCODES

byte j+l = 6

byte j+2 = 1

byte j+3 = 0 (zero)

byte j+4 = opcode
byte j+5, j+6 = 63, 63 = ASCII for "7?" (two question marks)

Exhibit 22-3. Instruction Disassembly Mnemonic Table Specification.
This describes the structure of the mnemonics table used in disassembly-
You must have a table like this for every processor for which

disassembly is to be performed. (Except the 280 and 8085, for which the

disassembler has mnemonics built in.) The maximum size allowed for this
table is 3K bytes.
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After the 256 packets for the possible opcodes, a terminator byte
marks the end of the table. It is simply one byte containing a binary
zero (0). Note that the maximum size allowed for the table is 3K bytes.

Since the file is a binary file, you need to use an assembler or

some other program that will produce binary output to create it. We

suggest that you use an editor to make an .ASM file, then use ASM and
LOAD to make hex and binary versions. Rename the binary version of the
file to change its extension from ".COM" to ".LAM".

Exhibit 22—4 at the end of this section shows the mnemonics table

(in the form of an .ASM file) for the 8048 microprocessor.

22.9 COMMAND FORMAT

Anytime the prompt line

Enter: c,D,E,F,G,H,I,L,M,N,0,P,s,T,w,x,z,=,7,(sp),“P

appears, the data in trace memory may be displayed in Instruction

Disassembly mode using a command in the following format:

I Display data in Disassembled Instruction format, centered on

the sample marked with the cursor in the previous display.

Ix Display data in Disassembled Instruction format starting from

sample number x.

22.10 COMMAND EXAMPLE

156 Display data as disassembled instructions starting at sample
number 56.

22.11 HELP PAGE

To obtain the Help Page for this function, type "?I".
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DI SASSENBLV SOURCE

Du TBLEND ;END OF TABLE

DB 007H~01-00-00~‘NDP’ DE< OODH,(!1,00.SCH, ‘HDVD F'4.A‘DB OObH.01.00.011""" DB 00DH,IZvl,OO.3DH, ‘nuvD P5,A’DB ooEH,01,oo.02.'DUTL BUSJY
pa c»oDH,01,oo,SEH,’Mn«/n F'éu,A’DE OOEIH.01.01,0.». ADD AJV
up OQDH,O1.00,3FH.‘NDVD P7,A’

‘

DE oon.01,01.04. JNF‘ PAGE our DB OODH.(¥1.0C>.40H,‘UF(L mano‘DB 007H.Ol.0fi.05.‘ENI‘ pa oopH,o1,oo,41H,‘DRL A.9R1‘
,DB 006H.01.00.06 2’?

pa <>0BH.01_00,42H.'MOV A,T'DE OI:r‘?H,O1.00.0 ’DEE A‘ pa OOEH,OI,01,43H.'URL 90"DB 0'3EH-01-00.08.
‘

INS. A. BUS‘ DB OlOH.Ol,Dl.44H. 'JHP PAGE :m’DB 005H.01.rn‘1,0<1. ‘IN A.F‘1‘ DE 00CH.01,00,45H, ‘STRT CNT'
DB (MEG-1,01. m.oAH,

‘

1N A.F‘2‘ DB ooaH,cwx,01,46H. ’JNTI‘
05 006K. 01.- .OE‘H, "-‘7’ DE! cn:AAH.nl.oo.47H. ’swAP A'
DE< oonH.ox.ru:w.OCI-L ‘MCND A.Pa‘ pa 00mm. .48H.‘DR‘L A.P.0‘
DE oaDH.01. '0.CIDH_. 'nuvn A.PS‘ pa OOCH.C'1.r2rO.47H.‘DRL GJN'DB oonH.01.oo.oEH. ‘MDVD A,F'b‘ DB c:oco—I.ox,o .4AH.‘uo=:L A.R2‘DE 00DH,01.00.0FH, ‘MDVD A.P7' pa OOCH,CI1 ,4EH. ‘DR‘L as?DE OOEHJLOOV 10H.

‘

INC aRO‘ pa OOCH.O1,00.4CH. ‘ORL A.F<4'DE DOE-4.01.00. 11H. ‘INC am' 93 O‘ICH,01.00,4DH. ‘DRL A.F.5‘
DE 007H.Cu.01, 12H. 130‘ DE vcH.o1. .4EH. ‘DR’L cumsDE octh.01.ox. 1: . ‘ADDC AJO‘ pa (ICACH,C)1.0,.4F‘H, ‘DRL A,F<7'DB o11H.o1.cv1.14H.‘cALL PAGE DJ“ 95 EHDDH.O1.00.SUH.'ANL A.DRO’DE 009H.Crl.00.15H.'DIS I‘ as u: H,01.00,51H,‘ANL A,.DF<1'DE 007H.01.01.16H. ‘JTF‘ DE. rm7H.o1.o1,52H, ‘JEE'
DE C109H,01.00.17H.

~

INC A’
DE LwaH.ox.Ox,SSH, 'ANL myDH OOAH.01.CIO.IEH.

‘

INC RO‘ pa OllH.Ol.Ol,54H, ‘cALL PAGE zm‘DE ooAH, 01. oo. 19H.
‘

INC R1
'

pa LIOAH. 01 .c~:w.55H. ’STRT T‘
DB OOAH.01.00. 1AH.

'

INC RZ’ ma oo7H.Cu,Ol.5é-H, ‘JTI
‘

DE< 001404.: .00.IEH.‘INC RS’ 03 OL‘rSH.Ol.OO,S7H. ‘DA A‘
DE 009mm, . lCH. 'mc R4‘ 135 OOCH,C)1,00.SHH. ‘ANL ARC"DE OOAH.‘ .0 .1DH,‘!NC RS’ ma OCrCH.x;u.OO,S‘7H.‘ANL may
DB oqu.o1.oo. lEH.

‘

IN: Rb‘ DE. 00CH.01. ,o,5AH. ‘ANL A.R2'DE 004mm. .1FH.‘INC FO‘ pg o.J(:H.v'u.m_.ssH, ‘ANL AJG‘DB 000:4,ch .oo,2c:H. ‘XCH mano‘ DE CroCH.m.Lro,SCH. ‘ANL 9.5:4‘DE OODH.r1.'0.21H. ‘XCH A,G>Fu‘ DE Curran-4.0x. ’IHSDH, ‘ANL A.R5‘pa 00w 'w1.r:>0,22H,""‘-‘ ma ocvcmmd .5EH.'ANL A.Ré'
DE ooaH.r_I1.ox,23H,‘n0v Any pg oochLO .SFH.’ANL A.F<7‘pa o1un.cu,o1.24H.‘JMP PAGE 1...‘ pa

'

nonmano’DE ooCH.ox.oo.25H. ‘EN TCNTl‘ DB 'ADDA.3R1‘DE ooaH.cu.ox,st. ‘JNTO‘ DE ‘MOV na‘
DB cwt>9H.cv1,oo,27H, ‘CLR A' pg ‘7'"
DB OOCH,L‘>1.00.ZBH.‘XCH A.RO‘ 93 \mp PAGE LavDE (IOCH,(\1.00.29H. ‘XCH A.RL' 93 com, , , ‘STUF‘ TCNT‘
DE OOCH.01,00,2AH,‘XCH A.R2’ op OOeH,O1,00,aéH. ‘77"

DB OOCH,01.00.2EH, 'XCH mar my 009H,OI.OC),57H, ‘RRC A"
DE OOCH,01. on . 2CH.

‘

mm A. m' pg 00, bBH. 'ADD A. 90‘
DE OOCH.L’|1.00.ZDH, ‘XCH A,F¢5‘ pa oocmumcnwu, ‘ADD A.R1‘DE OOCH.(I!.OO,2EH XCH may DE 00CH.01.00.6AH,‘ADD A.F.‘2‘DB OOCH.OI.OO.2FH, XCH A,R7‘ pa OOCH.01,00.6E4H. ‘ADD A.F<3’ma o:::EH.o1.oo,:oH,

'

XEHD mos-0' DE .oo.6CH- ‘ADD A-R‘VDB OOEH.01.00,31H, ’XCHD mam‘ pa oocnawhcrcusbm ‘ADD A.RS‘DE 007H,01.01.32H, ‘JBI‘ DE OOCH.CI1.C> EH. ‘ADD A.Ré‘ma 0c:sH.ox,oo.::H ”90'
DB OQCH.::r1,o_.eFH, ‘ADD A.R7’DE 010H.01.ox,:4H.‘:ALL PAGE 10' DE OOEH.01.00.70H.‘ADDC AJRO‘DB oonH.01,oo,:5H, ‘ms YCNTI' pa OOEH,OI.OO.71H, ‘ADDC mam’DB OO7H,01.01.36H,‘JTO‘ pa 007H,01.01.72H,‘J 3‘

DB 00‘IH.01. 00, 37H, ‘CPL A’ DE Crow-4,01, (>0. 73H.
‘

‘57”

ha oosmohoofisu, ’7'»
pg ouH,o1.o1.74H. 'CALL PAGE :m‘DE OOBH,01,00.39’H, 'OUTL P!.A' DEI OOCH,OI,00.7SH. ‘ENTO CLk'

DB OODH, 01,00. 3AH, ‘DUTL P2,
,

DE! 007H.(11,01. 76H. 'JFI
'

DB noel-4.01 .00,38H,
=

7'.” pa 008H,Ol , 00. 77H, ‘RR A'

DB OODH,m,0 .7BH,‘ADDC A.RO‘
DB oopmouocJ‘m, 'ADDC mar
DB oonH.ox.oo,7AH, ‘ADDC A,R2‘
DB OODH,01,00,7BH, ’ADDC A,R‘3‘
DB oopH.01.oo,7CH. ‘ADDC (ms-4‘
DB oonH,m,oo.7DH, 'ADDC A,F<S‘

Exhibit 22-4. Mnemonics table for the 8048 microprocessor. This is an

assembly language source file, designed to be assembled using ASM, the
Digital Research assembler supplied with CP/M. This listing is provided
here as an example; the compiled file is included on the Logic AnalyzerDisk as 8048FAM.LAM.
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The algorithm that produces the Histogram Display works as follows.

It looks through the Sample Memory for sample data falling in the range

specified in Items 1 and 2; let us call those "in-range samples." An

in—range sample will sometimes appear in a "run" of in-range samples
(that is, with other in-range samples before or after it, or both) and

sometimes all alone. .

Two questions are of interest here. First, how long are the "runs"
of in-range samples - how many samples are there in each run? Second,
and more important, how are the samples distributed in the runs of

different lengths - how many samples fall in short runs versus long
runs? So the histogram algorithm identifies the "runs" of in—range

samples, sorts them into categories by length of run, and then counts

the number of samples in each category.

Refer now to Exhibit 23-1. The column on the left gives run

lengths, that is, "6-9" means runs 6 to 9 samples long. The second

column is the percentages of in—range samples that fall in the runs of

different lengths. The exhibit shows that 3% of the in—range samples
fall in runs 6 to 9 samples long.

Note that the base for the percentage (100%) is the total number of

in-run samples in the Sample Memory. Thus the percentages shown in the

histogram will always total (approximately) 100%.

This may be applied to computer operation as follows. A

microprocessor fetches instructions from memory in a sequential fashion,
incrementing its program counter one, two, or three bytes, depending on

the length of the instruction. Program loops or branches, however,
cause the sequence to change. While a program may have no more than a

dozen instructions within a certain address range, if a loop is there,
the processor may make thousands of instruction fetches all within in

that same address range.

Thus long "runs" of instruction fetches within a certain range of

addresses reveal intense activity within that part of the program. By
making a number of Histograms Displays with different range settings,
you can identify which parts of the program are using the most execution

time.

There are three steps to using the Histogram function.

First, attach the probes to the appropriate points in the equipment
you are testing. Set up the data collection conditions on the Trigger
Menu and (if necessary) the Options Menu.

Second, call up the Histogram Display with the H Command and enter

the desired parameters in the menu items - the upper and lower limits of

the range in Items 1 and 2; if multiple accumulations for better

statistical averaging are required, the desired number of accumulations

in Item 3; and if run length categories other than the default values

are desired, the Scaling Factor in Item 4.
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Third, type "C" to cause data collection. Each repetition of the G
Command collects new data.

23.2 HISTOGRAM MENU

As with the other menus, type the item number to put the entry
cursor on a menu item. The following paragraphs give more details about
the individual menu items on the Histogram Display.

Item 1) Start of Range:

Enter the lower limit for the range in this item. The lower limit
must be a number between 0000 and FFFF hexadecimal (O and 65,635
decimal). The default radix is hexadecimal. The number entered should
contain a radix suffix (e.g., D for decimal, O for octal, B for binary)
if some value other than hexadecimal is input. Numbers entered in octal
will be immediately converted to hexadecimal on the display.

The value entered here also depends on the active channels selected
in the Trigger Menu, T Command. Channels that are not active are

treated as "don't care" values both in the data sampled and in the
numbers specified in Items 1 and 2. For example, if only the lower

eight channels are active, and they are connected to a computer address

bus, then all address bits except the lower 8 will he "don’t cares".
This will usually increase the number of samples that will be counted as

in-range.

Inactive channels are assigned a binary value of 0 for display in
this item. For example, assume that 3333h is entered in this item while
Channels 1 and 0 are inactive. The Omni converts 3333h internally to

its binary equivalent, "0011 0011 0011 0011". Since Channels 0 and 1,
which correspond to the last two bits, are inactive, the last two bits
are changed to "00", so the binary number becomes "0011 0011 0011 0000".
The hex equivalent, "3330", is then displayed in Item 1. All this is
done automatically when you type in "3333".

Item 2) End of Range:

Enter the upper limit for the range in this item. The comments

above regarding the number entered in Item 1 also apply here.

Item 3) Number of Accumulations:

The Histogram function can perform repeated accumulations for
better statistical accuracy. Each individual histogram (left set of
bars in Exhibit 23-1) is generated from the 1000 samples of one data
collection cycle. For some applications, 1000 samples may not be enough
to give statistically significant averages. With a sufficient number of
data collections, however, a good statistical account of the event can

be generated on the cumulative histogram (right set of bars). Enter the
number of repeated collections desired in this item. If a 0 (zero) is
entered in Item 3, the Omni will repeat accumulations until the space
bar is pressed.
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Item

Here

4) Range Scaling Factor:

"range" in the name of Item A means "run lengths." Nine

categories of run lengths appear to the left of the display. The

default categories divide the in—range samples into runs of 1, 2—4, 5—9,
10-19, 20-49, 50—99, 100-199, 200-499, and 500+ samples. For an entry
to be made in the 2-4 category, for example, the data collected must

have fallen within the range specified via Items 1 and 2 for at least 2

but no more than 4 consecutive samples.

Finer resolution can be obtained by scaling. Scaling by a factor

of 10 will then put the top category at 50+ and the shorter periods
proportionately narrower. If scaling is desired, enter the scale factor

in Item 4.

23.3 DISPLAY CHARACTERISTICS

Features of the statistical data produced by the Histogram function

and shown on the display are:

Samples - the categories of run lengths for which statistics are

collected: runs of 500+ samples, runs of 200-499 samples, and

so on in the default case. The example in Exhibit 23-1 uses a

Scaling Factor of 10, yielding run length categories of 50+,
20-49, and so on.

Z - the percentage of in-range samples falling in runs of the

Freq

various length categories. The base for the percentage is the

total number of in-range samples, that is, the samples lying
in the range given in Items 1 and 2. In the example shown in

Exhibit 23-1, 3% of the samples lying within the range OOOOH

to BFFFH are in runs of 6 to 9 samples; 1% lie within runs 5

samples long; and so on. The first Z column expresses the

statistics for the most recently collected data.

of Last Sample - histogram prepared based on the data most

recently collected by the G Command. The bar length is

proportional to the percentage to its left, just defined

above.

2 - same statistic as that contained in the first Z column, except
that it expresses statistics accumulated (averaged) over a

number of data collections. In order to get enough data to

make a statistically significant histogram, it may be

necessary to accumulate data over several samplings. The

example shows a histogram accumulated during 100 data

collections.

Cumulative Frequency - histogram based on statistics accumulated

(averaged) over a number of data collections. The bar length
is proportional to the percentage just to its left.
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23.5 HELP PAGE

A Help Page for this function appears in response to "?H". When
viewing the Histogram Display, Help Pages for the individual menu Items
1, 2, etc., may be accessed by typing "’21", "'22", and so on. After

viewing a Help Page, press <SPACE> to return to the Histogram Display.

Rev. D
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24. SIGNATURE ANALYSIS

24.1 INTRODUCTION

A signature is a checksum calculated from the data stream passing a

circuit node. A very powerful troubleshooting technique, signature
analysis is used to isolate faults in defective circuit boards. The
user compares the signatures at various points on a malfunctioning board
to the signatures for a known good board.

The Omni's signature analysis function is controlled by a combined
menu and display which appears in response to the S Command. Exhibit
24-1 shows an example of the menu and display.

Dianne I Saw le Reference
1) Start on: LIB-PINE: lw LEVEL TEST-POIHT—D BIN-1E(—) E53

l3-PIN25 BT27 (—) 293E
2) End on: HIE-PINS LC“ lEVEL uas—le (—> BM

J3—PIN23 (—> 7CSB
3) Clock Polarity: NEG HBE U12-PIN3 m1 (—) 0183
4] Clock (hatifg: [INT ORE thl-PlNll (—> 413

U43-PIN5-DECG7D $76 (—) B788
5) Trig Enable on: MT CHI LEM-{HUGO B788 B788

U9-14—-CL(X:K(B) 3:18 (—> ZSEE
6) Save to fi [9: U7-9---CL(£K[R] 6533 6933
7] Read from file: 53 L147-P1N16 3738 <—) $75
8) Read setup fi le: TEST-POINT-R B788 B788
9] [blete signature ft le: U4-9-SYNC‘DET 3-118 <—) SEE

Number of Sanples: 1812 [Hm-INPUT 65133 6933

Enter 1-9, G to senate, P, P, (space) to exit

Exhibit 24-1. Signature Menu (left) and Display (right two colLunns).
Sample signatures that differ from the Reference signatures are marked
by a "<-~>" symbol and highlighted.
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The signature analysis algorithm generates a four digit hexadecimal
number. Many manufacturers of digital electronic products now provide
signature test points and correct signatures in their service manuals,
making signature analysis possible on the service bench as well as the

production line.

The Omni can perform signature analysis on up to 14 test points
simultaneously. It can collect "reference good" signatures; store them
on disk; recall them from disk; and collect test signatures and compare
them to the reference signatures.

There are three steps in performing a signature analysis:

First, connect the probes to the equipment to be tested. Connect
the Omni's Clock probe lead to a circuit point carrying the clock signal
that will be used. When collecting signatures, the Omni uses the DO
line to sense a Start signal and the D1 line to sense an End signal;
connect the probe leads to those signals. Finally, collect one or more

of the other 14 data lines, D2 through DF, to the circuit nodes at which
the signatures are to be taken.

Note that any one, all, or any combination of the 14 lines may be
used simultaneously, making thorough testing at multiple test points
very easy. (In fact, when used with a bed—of-nails board test fixture,
the Omni will perform most of the functions of a large production board
test system at a fraction of the cost.)

Second, enter the appropriate parameters on the menu - polarities
of the Start and End signals, Clock Polarity, and if desired, Clock

Qualify and Trigger Enable conditions. If comparison with Reference

signatures saved on disk previously is desired, enter the name of the
file in Item 7. (How to put the Reference signatures on the disk is

explained below.)

Third, type "C" to collect samples and generate the test

signatures, which will appear in a column under "Sample". Any
signatures which differ from the corresponding Reference signatures to

the right will be highlighted.

Reference signatures are created by collecting signatures from a

known good board; saving the signatures to a disk file using Item 6;
then recalling the disk file data to the Reference signature memory
using Item 7. Details on this and other aspects of using signature
analysis are given below.

NOTE: Reference signatures can be saved to disk and recalled only by
using Items 6 and 7 on the Signature Menu. The save and recall
functions on the File Menu operate only on sample and reference data,
which are different from sample and reference signatures. Signature
files have extension ".LAS", while data files have extension ".LAD".
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24.2 MENU ITEMS

Details about the individual menu items are given in the following
paragraphs.

Item 1) Start on:

All signals entering the logic analyzer are ignored until the level

specified for the Start level (high or low) is detected on Channel 0.

Signature generation begins with the first sample collected after the
start condition is satisfied.

Enter a "1” in Item I to indicate a high Start level, or a "0" to

indicate a low Start level.

Item 2) End on:

Enter a "1" in Item 2 to indicate a high End level, or a "0" to

indicate a low End level.
!

Signature generation continues for all samples collected up to, but
not including, the sample during which the end condition is satisfied.
If an End signal does not occur within 1000 samples of the Start signal,
signatures will be calculated based on the first 1000 samples after the
Start signal. Thus if it is important that the signatures be based on a

hardware End signal, take care to select an end condition that will
occur within less than 1000 samples of the start condition.

Item 3) Clock Polarity:

Signature analysis requires an external clock signal from the

equipment under test. Internal clocking is inappropriate for signature
and is not allowed. Select the external clock edge that will provide
valid data for the type of circuit being tested. For example, if a

microprocessor's active low read control line is used as the external
clock input, then the positive edge would be used to collect data since
the processor data bus is stable on the positive edge. Enter a "1" in
Item 3 to indicate clocking on the positive (rising) edge, or a "0" to

indicate the negative (falling) edge.

Item 4) Clock Qualify:

Data collected for signature analysis is recorded on the clock

edge, but only when the Clock Qualify line is at a specified level. If
no qualification is desired so that every clock edge records a sample,
then the "don't care" condition should be used. If data collection is
to occur when the qualify line is at a high level, enter a "1". Enter a

"0" to allow data collection only when the clock qualify line is at a

low logic level. Entering "X" makes this item "don't care", which is
the default condition. This function increases the flexibility of data
collection.
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Item 5) Trig Enable on:

The Trigger Qualify line can be used to enable the Start condition,
so that data collection begins only when both Channel 0 and the Trigger
Qualify line match their specifications. Enter a "1" in Item 5 to

achieve trigger enable on a high level. Enter a "0" to achieve trigger
enable on a low level. If you do not wish to use trigger enable to

qualify Start collection, enter an "X".

Item 6) Save to File:

Signature values for all fourteen channels can be saved on disk for

later reference by entering the filename under which they are to be

saved in Item 6. Enter a filename of up to eight characters. A drive

specification can also be included per the usual operating system
convention (e.g., B:FILENAME). The extension ".LAS" is automatically
appended to the filename; if a extension is entered, it is ignored.

The setup information used to collect the data is also saved on

disk. The Reference signatures are not saved. (They are already on

disk, and will remain there.) The saved data can be retrieved by using
either Item 7 or 8.

Item 7) Read from file:

Signatures which were saved with Item 6 can be retrieved and placed
in Reference Memory for comparison with the newly sampled signatures.
Sample signatures that do not correlate with Reference signatures are

highlighted. Enter a filename as in Item 6 above. If the file does not

exist, a message to that effect will be flashed on the screen.

Item 8) Read setup file:

This item allows retrieval of signatures and set—up information

stored on disk. The hardware will then be configured according to this

set-up information. This option can be used to repeat a test performed
at an earlier time.

Item 9) Delete signature file:

To delete a signature file, enter its name (without the extension)
in Item 9, followed by <RETURN>. It will be immediately erased from the

disk.

Number of samples:

This parameter on the menu shows the number of samples used in

generating the signatures, which is equal to the number of clock cycles
between the Start and End signals.
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24-3 HELP PAGE

A Help Page for the Signature Analysis function may be called up
with "’25". When viewing the Signature Analysis Menu, you can call up
individual Help Pages for Item 1, Item 2, etc., with the commands "2’1",
"?2", etc. After viewing the information, press <SPACE> to return to

the Signature Analysis Menu.

Rev. D
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25. PRINTER OUTPUT

25.1 INTRODUCTION

Any of the data displays — such as Waveform, Edge, Dump,
Instruction Disassembly, Histogram, Matrix, Signature, etc. -

may be

sent to a printer for a permanent hardcopy record by using the CTRL-P

Command, Printer Output. CTRL-P ("control P") is activated by holding
down the <CTRL> key and striking the "P" key. The "P" key can be upper
or lower case.

25.2 COMMAND FORMAT

Anytime the prompt cursor appears in the lower left corner of the

screen, you can use one of the following formats to print what is shown

on the screen:

CTRL-P Print the information displayed on the screen.

CTRL-Px Print the information shown on the screen, starting
at sample x.

CTRL—Px,y Print the collected data from sample x to sample y,
in the same format in which it was last displayed
on the screen.

CTRL—P? Print all Help Pages on the printer.

The samples x and y may be designated either by the sample numbers,
or if Internal Clock is being used so that there is a meaningful time

scale, by the sample times.

25.3 EXAMPLE

CTRL-P 10,50us Print data from sample number 10 through the sample
collected 50 microseconds after the trigger. The

display mode will be the same as last shown on the

video screen.

25.4 CONNECTING THE PRINTER

Either the Parallel Port or Serial Port may be used to drive the

printer. Normal output is to the Parallel Port. If you wish to use the

Serial Port, use the CP/M program STAT to direct output to the the

Serial Port:

A0>STAT LST:=TTY:

Further information on setting up the ports (baud rate, etc.) for

your printer may be found in the user's guide for the computer.

The Omni expects to receive standard "ready" handshaking signals
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from a printer when data is sent out. If you use the CTRL-P Command and

no printer is connected, the Omni will go into a wait loop, waiting for

a nonexistent handshake signal. To recover from this, use the Reset

function and start over. Any data in the Sample Memory and your

parameter settings will be lost when you use Reset. To avoid this, make

sure a printer is connected and operable before you use the CTRL-P

Command.

Omnis manufacture before mid-1984 have a single serial port, while

units made later have two serial ports, one for a printer and one for

data. On the units with one port, the port is configured as a DTE port
under the RSZ32C standard. Serial data is sent out on pin 2 of the

connector, and received on pin 3- When used for printing as the LST:

port under CP/M, it requires a HI handshaking signal from the printer on

pin 5. If your printer does not provide this signal, you can jumper pin
5 to pin 6, where a HI signal is present.

On the units with two serial ports, The data port (labeled "J4
SERIAL DATA I/O") is configured the same way as the single port
described in the previous paragraph. It is not accessed as the TTY:

port by CP/M, however; your applications software (such as a modem

program) will access it directly.

On units with two serial ports, the printer port (labeled "J3
SERIAL PRINTER 0UPUT") is the CP/M TTY: port. It is configured as a DCE

port under the RSZSZC standard. Data is sent out on pin 3 and received

on pin 2. Pin 20 is used for handshaking; it must be driven HI for data

to be sent out when this port is made the LST: port using the STAT

command. There is no handy HI signal source present on the connector.

In printing waveforms, the Printer Output function uses the

underscore "_" to represent a low, the tilde
"~"

to represent a high,
the slash "/" to represent a leading edge, and the backslash "\" to

represent a trailing edge. Many dot matrix printers allow downloading a

custom character set which gives a better graphic representation of

waveforms. The character downloading may be performed by a small

program which is run before loading the Logic Analyzer Program.

Exhibit 25-1 shows an example of such a program, and Exhibit 25-2

shows the resulting waveform printout.

25.5 HELP PAGE

A Help Page for the CTRL-P Command may be accessed by typing
"?CTRL-P".
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0005 =

0005 =

0013

OOFF =

0100

0100

0103

0104

0106

0109

010A

0103

010D

0110

0111

0112

0115

0118

0113

0134

0137

0142

0145

0148

0149

EXCEPT:

(/)

(\)

w-

~4-

m

a.

.-

..

-..

u.

u-

(I)

u.

w

.-

3005 E00
LSTFUNC EQU

= ssc EQU
TERM EQU

ORG

PRINTING THE UMNI II

gemini—IOX PRINTER.

WHICH

DIRECTIONAL PRINTING.

THIS PROGRAM CREATES A DOWNLOAD CHARACTER SET FOR

TIMING TRACES ON A STAR

ALL CHARACTERS ARE STANDARD

IS CHANGED TO A VERTICAL LEADING

EDGE WITH A FLAT TOP.

WHICH IS CHANGED TO A VERTICAL TRAILING

EDGE WITH A FLAT BOTTOM.

WHICH IS CHANGED TO A FLAT TOP.

VERTICAL ALIGNMENT IS ALSO ASSURED BY SETTING UNI-

NORMAL PRINTER OPERATION MAY

BE RESTORED BY TURNING IT OFF AND THEN ON AGAIN.

*PROGRAM EQUATES*
05H

05H

13H

OFFH

lOOH

;DOS ENTRY VECTOR

;DOS LIST FUNCTION

;ASCII FOR ESCAPE

;STRING TERMINATOR

; THIS ROUTING READS AND TRANSMITS THE CONTROL

; SEQUENCES LOCATED AT "STRING".
211501 DNLDCHR

7E DNLDZ

FEFF

CAOOOO

E5

5F

OE05

CD0500

E1

23

030301

lBZAOO STRING

132A01

2F007F0001

132A01

50017F0040

lBZAOI

7E00010001

132401

185501

FF

LXI

MOV

CPI

JZ

PUSH

MOV

MVI

CALL

POP

INX

JMP

DB

DB

DB

DB

DB

DE

DE

DE

DB

DB

END

H,STRING
A,M
TERM

0

H

E,A

C,LSTFUNC
BDOS

H

H

DNLD2

ESC,’*',O

ESC,'*",1
2FH,O,7FH,

ESC,’*’,1

5CH,1,7FH,

ESC,’*’,1

7EH,0,1,0,

ESC,’$',1

ESC,’U’,1

TERM

;GET POINTER

;GET A CHAR

;TERMINATOR?

;YES, RETURN TO CP/M
;NO, SAVE POINTER

;CHAR T0 E REG

;AND OUT TO PRINTER

;RESTORE POINTER

;BUMP POINTER

;AND GET NEXT CHAR

;copxgs STD CHAR’S TO

;DOWNLOAD RAM.

;CHANGES /

0,1,0,1,0,1,0,1

;CHANGES \
O,4OH,0,40H,0,40H,0,40H

;CHANGES
‘

1,0,1,o,1,o,1

;ACTIVATES DOWNLOAD SET

;SETS UNI-DIRECTIONAL

;PRINT

Exhibit 25-1. Hubert Evinger of Advanced Computer Concepts, Inc., Costa

Mesa, California wrote this CP/M program for downloading special
waveform characters to 3 STAR gemini-IOX printer.
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——————

+———~+~—a—+————+————+————+——-~+————+————+~-——+————+~——~+~——

CS
______________________________________

Lwr
_______________________

Lfi__________-_-~__»____-_____”--‘_____0

w——+————+—‘~~+w--—+————+-———+———»+————+«~——+———

—19 “14 —9 -4 1 b 11 1‘a :1

B88888888888BBBBBBBBBBBBBBBSBBBBBBBBBBBBOOBBBBBBBBBBBBBBBBBBBBBBB
DOOOQDOOQOODDI.I' 0111111111111111111111111111111111111111111

JOll1111111111111111111111111111111111111111

320202020202020203024545464b4b4é4é4é46454b4

E######_####J SM

Rate 60.0u5 Delay 0

Exhibit 25-2. Example of waveform printout after a special character

set has been downloaded to the printer by the program in Exhibit 25—1.
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26. THEORY OF OPERATION

26.1 INTRODUCTION

What is a logic analyzer?

A logic analyzer is an instrument for collecting and displaying
digital data. Used primarily for testing digital equipment, it has

input probes that may be connected to integrated circuit pins inside the

equipment under test.

A logic analyzer records the logic levels on many lines, over a

period of time, and then displays the recorded patterns. By examining
the collected data, you can trace the operation of the digital circuit.

The logic levels are sampled in step with a clock signal. The

clock signal either may be generated inside the analyzer (Internal
Clock), or may be taken from the equipment under test (External Clock).
Each sampling stores one data word in the logic analyzer's Sample
Memory. The analyzer continuously collects data in memory until a

trigger event, which may be either recognition of a specific word in the

data stream or an external event, causes it to stop.

Like an oscilloscope, a logic analyzer collects data corresponding
to voltage versus time and displays it as "traces". Two features make
the logic analyzer a very powerful tool:

A) It can collect data on many lines at once; in the case of the

Omni, on 16 lines, or, with the the 32 Channel Adapter, on 32 lines.

Observing the bit stream on a single line at one time, as with an

oscilloscope, is of little value, since the bit pattern is meaningful
only in reference to the simultaneous bit patterns on other lines.

B) The logic analyzer collects data prior to the trigger event,

again unlike an oscilloscope, which starts the trace after the trigger
event. When a digital circuit goes awry, the cause is usually found in

what happened beforehand, not afterwards.

The logic analyzer has two limitations compared to an oscilloscope
- it records voltage as only "high" or "low" (binary 1 or 0), losing the
details of waveform shape. Also, it records the logic level only at the

clock transitions, thus limiting the time scale resolution to the

minimum clock period that the logic analyzer can handle. (This
disadvantage is partially remedied by the inclusion of glitch collection

capability.) The Omni will accept a clock rate of up to 20 MHz,
yielding 50 nanoseconds resolution. Also, there is a trade-off between

resolution and length (in time) of the trace; since the Omni can store

only about 1000 samples, at the finest time resolution it can store only
50 nanoseconds x 1000 = 50 microseconds of trace. In practice, this

limitation proves to be of little hindrance and 1000 samples are quite
adequate.
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SAMPLE

MEMORY
INPUT

DATA 16K x 1K

35 n5

TRIGGER ADDRESS

RECOGNIZER COUNTER

CLOCK CONTROL

INPUT COUNTER

Exhibit 26-1. Diagram of the logic analyzer. The Input Data is picked
up by the analyzer probes. The Clock Input can be either an External
Clock signal picked up by the probes, or the analyzer's Internal Clock.

26.2 HOW ll WORKS

The heart of the logic analyzer is the Sample Memory (see Exhibit
26—1). As the Clock Input provides clock pulses, the Sample Memory
stores samples, one sample for each clock pulse. The clock pulses also
step the Address Counter, so that samples are stored in successive
addresses in the Sample Memory.

The Sample Memory is 16 bits wide and holds 1024 words, that is, it
has 1024 addresses, from 0 through 1023. When the Address Counter
reaches 1023, it "rolls over" and stores the next sample at Address 0.
Thus old data is continually being overwritten as the analyzer collects
new data.

The Trigger Recognizer is also connected to the input data stream,
and will have been set (via the Trigger Menu) to detect some combination
of bits (the trigger word) in the input data. When the Recognizer
detects the trigger word, it initiates the trigger sequence.

The trigger sequence consists of two steps. First, the analyzer
continues to collect a certain number of additional samples. The
Control Counter manages this, and the purpose is to provide samples in
the stored trace after the trigger event, as well as before. (The
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number of samples collected beyond the trigger event is entered as the

Trigger Point on the Trigger Menu.)

As the second step of the trigger sequence, the analyzer displays
the collected samples. The software automatically formats the display
according to the parameters entered in the Trigger Menu, which usually
call for the trigger event to be labeled Sample 0 and displayed in the

center of the screen. The Omni does not display all of the 1024

samples; because of timing uncertainties in the collection process, a

few samples at the ends of the trace may be invalid and the Omni

excludes them from display.

26.3 TIMING ANALYZERS AND STATE ANALYZERS

Early logic analyzers were one of two kinds, either state analyzer
or timing analyzer. The state analyzer was clocked by some cyclical
event in a computer, and recorded the "state" (combination of logic
levels) at some set of circuit points. It was used for tracing the

operation of a computer circuit as it moved step-by-step through its

cycle.

When connected to the address bus, and connected to use a read or

write control pulse as its clock signal, the state analyzer would trace

the sequence of memory reads and writes, thereby tracing program
execution. The state analyzer's output was typically displayed as a list

of binary words expressed in 1's and 0’s.

The state analyzer, while showing the correct sequence of states,
does not furnish the data against an accurate time scale unless the

clock signal has a uniform and known period.

The timing analyzer, on the other hand, had its own internal free-

running clock, and capture data without regard to synchronization with

the circuit being observed. The data was shown in a format similar to

oscilloscope waveforms, which the timing analyzer was expected to mimic,
with the added benefit of multiple traces and before-the—trigger data

capture.

The timing analyzer does not show exactly the transition times of

the signals it is trying to measure, since the transitions that appear
are those of its own clock. Using a 50 nanosecond clock period, for

example, the timing analyzer shows a signal transition 0 to 50
nanoseconds after it actually occurs, depending on when the analyzer's
clock edge transition occurred compared to the signal being measured.

In order to achieve a reasonably accurate representation of the

measured signal, the timing analyzer clock has to be several times

faster than the frequency of the events being observed. A popular rule
of thumb calls for the timing analyzer’s clock frequency to be four to

five times higher than the fastest frequency to be observed.

High speed is more important to a timing analyzer than to a state

analyzer. A state analyzer need only be as fast as the system clock of
whatever it is measuring.
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The Omni has both Internal Clock and External Clock modes, allowing
it to serve as either a timing or state analyzer. Its 20 MHz clock rate

is fast enough to make it quite serviceable as a timing analyzer for

microprocessor based systems. This flexibility makes the Omni very easy
to use. Furthermore, regardless of how the data was collected, using
either internal clock (timing analzyer) or external clock (state
analyzer), the data can be displayed in either timing diagram format or

state diagram format. Once you have collected the data, you can display
it in several formats until you find the one most revealing. Generally
speaking, a timing diagram is most useful for studying hardware

operation, while a state display is most appropriate for tracing
software execution.

The Omni also has a Trigger Out signal which may be used to trigger
an oscilloscope for high—resolution examination of waveforms. This
enables you to see the data signals in detail - waveform shape, multiple
glitches, actual logic levels, and so on. The resolution, which is now

determined by the bandwidth of the oscilloscope, can be as fine as 1.5
nanoseconds with a 200 MHz scope.

The Omni’s triggering capability allows the oscilloscope to observe
events that are associated only with a certain data word, or with the

presence of glitches, or with a combination of both.

See Section 7 for further information on using the Trigger Out

signal.

26.4 SOURCES Q; ERROR

To summarize, the logic analyzer is subject to the following
limitations:

The square waveforms appearing in the Waveform and Edge Displays do
not represent the actual waveshapes of the signals being recorded.

Regardless of the actual waveforms, the input levels are recorded as

only H1 or L0 levels.

A transition in the input is not recorded until the time the next

sample is taken. Thus the transitions displayed correspond to the time
of sampling, not the transition points in the input waveforms.

Signal activity between sampling points is not recorded, with the

following exception. Transitions between sampling points are recorded
as glitches on the lower four channels, and will be displayed if glitch
display is activated.

Another possible source of error is loading by the analyzer inputs
on the circuit under test. This can be very significant with some types
of analyzers which use long ribbon cables (over 6 inches) and unbuffered
TTL or LS TTL chips for the input. The Omni series analyzers avoid
this by using high impedance (1 megohm) buffered probes with 6—inch

probe leads, which hold the capacitance to a few picofarads.

Rev. D
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27. APPLICATIONS

EXAMPLE L; A CRT controller that was not putting out any output signal
or responding to any input.

"First of all, I checked to see if the clock was running and which

lines had signals on them and which were dead.

"I put one of the 8 leads of one probe on the controller clock line

and the rest at various places in the circuit. The Trigger Menu's

"logic probe" display showed activity on the clock and other lines. I

then used the Omni’s default sampling conditions - Internal Clock, 50

nanoseconds Sample Rate - and took a sample.

"Looking at the Waveform Displays, I saw that the controller's

clock was operating properly. Some of the other lines had activity on

them and others did not. Moving the probes around and taking repeated
samples, I hunted to find out where the signals were getting stopped.
One 74LSl38 address decoder had lots of activity on the address and

enable pins, but all the output pins remained high. (The 7ALSl38

generates an active low output on one pin when it is enabled.)

Comparing the waveforms for the address and enable inputs, the chip was

enabled for address combination 5, which according to the data book

would cause a low output on pin 10 - and there was not. Obviously,
either the chip was bad, or a short was pulling the output high.

"I replaced the chip, and then the unit worked.

"Total cost - 40 cents in parts and 10 minutes."

Here, the technician was using the Omni to observe activity on the

signal lines. While a logic probe can identify active signals, it does

not provide any clue to the time relationships of the signals, as was

the key here. No sophisticated trigger settings were needed. The

Omni’s ability to display signals on many lines simultaneously isolated

a bad chip quickly.

EXAMPLE g; A microcomputer displays its turn—on message properly but

does not respond to the keyboard.

"I hooked up the Omni's 16 data probes to the address bus to see if

the Z80 was reading addresses. I used the system /MEMR (memory read)

signal as the clock. The Clock Qualify probe went on /Ml (pin 27 on the

280) to collect only opcode fetch addresses. I entered all 1's for the

Trigger Event. I pressed ’G' (for ’Go and Collect Sample'), let it run

for a second, then manually triggered it by hitting the space bar.

"I used '0 —500’ to display the captured data in hex.
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”Paging through the Dump Display, it was obvious that the Z80 was

looping over and over through about 20 bytes of PROM code.

"One of the addresses 2323B. I moved the cursor to 2323B on the

display, pressed the = key to enter it (2323B) as the Trigger Event.

Then when I ran it again, I would see in the trace how it got to 2323H.

"Then I pushed down the Reset button for the microcomputer, and

while holding the button down, typed ’G' on the Omni. The Omni started

collecting. I released the Reset button. The Omni stopped collecting
and went back to the Dump Display with the cursor on 2323.

"Looking at the display, I saw that it was executing PROM code

around 2080K just before making a jump to 231CH. Studying the listing
of the assembly language code I had written for the ROM, I saw that

there wasn’t supposed to be a jump like that around 2080B. Using the

clue provided by the Omni, I checked the PROM - sure enough, it had one

bad bit.

"Without the Omni, I could have spent hours looking for shorted
address lines in the system or studying the code listing looking for

errors. I wouldn’t even have been able to tell whether I had a hardware

fault or a software bug without hours of work. This only took me about
40 minutes, and most of that time was spent getting my tools together
and taking the cover off the microcomputer."
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28. ADVANCED APPLICATIONS

28.1 EXTENDING THE TRIGGER WORD

Some applications may require triggering on more than 17 bits (16
bits on the data lines plus 1 on the Trigger Qualifier allows an

effective 17 bit trigger word). Or, you may want to trigger on one 16

bit combination, such as a microprocessor address, while recording some

other data, such as 8 bits on the microprocessor's data bus.

With the Omni's External Trigger capability, you can trigger on a

word of any length by using some simple external circuitry to generate a

trigger pulse. Exhibit 28-1 on the next page shows a circuit that may
be used to trigger on a word of up to 64 bits.

The trigger word is identified by 8-bit comparators (Tl 74L5682).
For a 64—bit trigger word, eight such comparators are required with

their outputs ANDed. The schematic shows only one comparator; the

circuit for the others is identical.

The comparators' Q inputs contain internal pull—up resistors, so no

external resistors are needed. Each switch is used to set one bit in

the trigger word. Switch closed is a "0", switch open is a "1". For a

"don't care" ("X") bit, tie the P input of the L5682 high (+5V) and set

the corresponding switch open. The comparator will see a high on both

inputs, satisfying the trigger condition if all the other inputs match.

You can use fewer than eight 74L5682’s for fewer inputs. Tie the

unused inputs of the LS3O high (+5V).

28.2 COLLECTING DATA WIDER THAN LE BITS

Using the Trigger Pulse Generator will also allow you to collect

data wider than the Omni's 16-bit word by making more than one

collection pass. With the Trigger Pulse Generator recognizing the

trigger word, you can move the data probes around to collect multiple
sets of data.

For example, assume that you want to collect data on 32 lines.

Connect the Omni data probes to 16 lines, collect the data, reconnect

the probes to the second set of 16 lines, and collect data again. The

data from the two passes may be combined for 32 bits total.

Printer output is especially useful here. The data from each pass
can be printed on paper, then the two sheets spliced together for a 32-

bit "display". Given enough time, patience, and cellophane tape, you
can get data displays of any length word.

28.3 ADDED DELAYS AND LOADING

The delay from the P inputs of the 74L5682 to the output is

specified as 25 nanoseconds maximum. This delay adds a 25 nanosecond
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hold time requirement for the data signals; normally the hold time

required for the data signals is zero. If this proves critical to your

application, it may be necessary to put buffers on the inputs to delay
the data signals by a matched amount.

The comparator inputs add one TTL load to the circuit to which they
are connected. This will not be a problem for equipment with adequate
design margins, but it should be considered, particularly if other loads
are applied to the same circuit points during the testing.

Rev. 5—8-85

74L5682

s1

T7 _11_ P7 Q7 M
T6 ¢ P6 Q6 16—/
T5 __13_ p5 Q5 __/14
T4 __11 P4 Q4 __./1Z
T3 _8 pa Q3 _—/9
T2 4 p2 Q2 _7—/
T1 ‘4 Pl Ql 5_/
T93 ——2— P93 Q?) 3__/

T 19P Q 7 741504

l>$ 741.530)

> /TRIG

TO OTHER

COMPARATORS

[::x:

Exhibit 28-1. Trigger pulse generator. When the trigger word appears
at the inputs, a /TRIG signal is generated that may be used to drive the
Omni’s External Trigger probe line.
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29. 32 CHANNEL ADAPTER

29.1 INTRODUCTION

The 32 Channel Adapter is an accessory for the Omni that extends

its data collection capacity to 32 channels total. The added 16

channels are called Bank 1, Channels AF—AO. The original 16 channels

are considered Bank 0, and retain their original designations, DF—DO.

Four connectors on the Adapter accept four standard Omni buffered probes
(TTL or CMOS type), each of which handles 8 data channels.

_
The Adapter mounts externally, on the right hand side of the Omni.

See Exhibit 29-1. Two cables from the Adapter plug into the probe
connectors below the disk drives.

The control lines associated with the original 16 channels (Clock,
Clock Qualify, Trigger, and Trigger Qualify) remain identical.

The 32 Channel Mode also provides three clock inputs, called

External Clock, External Clock 2, and Multiplexer Clock. The latter is

useful for collecting data, particularly for Instruction Disassembly,
from microprocessors such as the 8085 that use a multiplexed data and

address bus.

Most of the Omni's functions are the same with the 32 Channel

Adapter, except extended to the additional channels. This section

describes the differences.

When the Adapter is installed, the Omni has two basic modes of

operation, 32 Channel Mode and 16 Channel Mode. In 16 Channel Mode, the

operation is nearly identical to that without the Adapter. 16 Channel

Mode is retained to provide some functions that are not available in 32
Channel Mode.

When using 32 Channel Mode, the maximum data collection rate is 10

MHz (100 nanosecond resolution) and the trace depth is 500 samples. The

maximum trigger word width remains 16 bits (17 bits including the

Trigger Qualify input). 32 Channel Mode is designed solely for use with

an external clock; it will not work with the Internal Clock. Also, no

glitch collection capability is available. Glitch collection and

Internal Clock are available in 16 Channel Mode.

29.2 INSTALLING THE 22 CHANNEL ADAPTER

The 32 Channel Adapter may be installed on the Omni with ordinary
hand tools. Follow these six steps:

a. Loosen the lower two Phillips-head screws that hold the

hood on the right side. Be careful not to scratch the finish.
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Exhibit 29—1. The 32 Channel Adapter is a slim box that attaches to the

right side of the Omni-

b. Slide one flange of the metal right-angle strip under
the hood.

c. Hook the fingers at the top of the 32 Channel Adapter
into the vent holes in the hood, so the Adapter hangs from the

fingers and the mounting holes on its lower edge line up with the
holes in the right-angle strip.

d. Insert the screws throught the angle strip into the

Adapter, and while pressing the adapter against the side of the

Omni, tighten them securely-

e. Tighten the screws holding the hood to the Omni on the

right side.

f. Plug the two ribbon cable connectors from the Adapter
into the connectors on the front of the Omni. The shorter ribbon
cable goes to the nearer connector.

Omni Operating Manual 29-2
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A7 —A¢ AF—AS

D7—D¢ DF-DS

Probe Data g Input Line 1 Input Line

1 D7-DO Ext Clock Ext Trig
2 DF-DB Clock Qual Trig Qual
3 A7—A0 Ext Clock 2 Not Used

4 AF-A8 Mux Clock Not Used

Exhibit 29-2. The buffered probes plug into four connectors on the side

of the 32 Channel Adapter.

Exhibit 29—2 shows the order in which the buffered probes are

plugged into the 32 Channel Adapter.

29.3 LOGIC ANALYZER PROGRAM

A special version of the Logic Analyzer Program called LA32.COM is

used to operate the Omni with the 32 Channel Adapter. The special
program also has a 16 channel mode, so that you can use the Omni as

before.

Five of the menus and displays have been modified to accomodate 32

channel operation: the Trigger Menu, Options Menu, Dump Display,
Instruction Disassembly, and the Locate Function. The shift between 32

Channel Mode and 16 Channel Mode is controlled by the Trigger Menu.
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Chamels

1) FHive Probes

bank (Rx)
2)Rt1|ve Glitch

Recog &auplngs :

3] Trigger Event

bank (Rx)
4) GIITCh Evean)

5) Trigger (Mal: X D) Max Clock: 8
6) Trigger Poini: 56 E] Recog Function: 1
7] Occurrence 1I: -) l-z-g-x-w-g
B] [klagz 2—[z-g-x-w)+g

H] CTR (hallfg:
B] Ex? Clock:

0 Ext Clock 2:

4-(z-g)+(x-w)
S-z-g-(x’rw)
E—Exfernal

F) Conplex Trg: N0

1

B
9) Tmeouf: 8 3-(fil-x-m

X
1

1

Index l-F, G-sfafl, P-prinf, ?, (space)

Exhibit 29—3. Trigger Menu used with the 32 Channel Adapter. The Omni

is in 32 Channel Mode here. When it is in 16 Channel Mode, Channels AF-

A0 are all blank in Item 1. Also, Items C and D are different; Item C

is used to enter the Sample Rate and Item C the Recognition Mode, the

same as when the Adapter is not used.

29.1; TRIGGER MENU

Exhibit 29-3 shows an example of the 32 Channel Trigger Menu. It

has several major differences from the standard Trigger Menu. Details

about the changed menu items are given below. Item 1 controls the shift

between modes.

Two menu items change when the mode is changed. In' 16 Channel

Mode, Item C becomes Sample Rate and Item D becomes Recognition Mode -

the same as in normal 16 channel operation without the Adapter.

Item 1) Active Probes

This item has been expanded to apply to 32 channels. The channels

are divided into Bank 0, DF—DO (upper row), and Bank 1, AF-AO (lower
row).

To make a given channel active, enter a 1 in its bit position; to

make it inactive, enter an X. Active channels are shown by a l or 0,
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and inactive changes are represent by a blank space. Use the cursor

arrow keys to move the cursor from one channel position to another, or

keys F,E,...2 may be used for direct cursor positioning.

32 Channel Mode is in effect whenever there are any channels active

in Bank 1 (AF-A0). The Omni switches to 16 Channel Mode automatically
when no channels are active in Bank 1. The default mode at turn—on is

32 Channel Mode, as shown in Exhibit 29-3.

Only the standard sixteen channels, DF-DO, have the logic probe
feature, that is, the ability to show the instantaneous logic state of

the probes.

Item 3) Trigger Event

This item is likewise divided into two banks, DF—DO (upper row) and

AF-AO (lower row). A trigger word may be entered in either bank, but

not both at the same time. Only one bank at a time can be active, which

means a trigger word may be recognized in either the DF-DO Channels or

the AF~A0, but not both. Accessing a bank makes it active, and the

other bank is automatically made inactive - all X's are displayed.

A trigger word formerly displayed in the inactive bank is saved

internally. Accessing that bank will again cause the trigger word to be

displayed.

Item B) Ext Clock

In 32 Channel Mode, there is no Internal Clock and an External

Clock is required. Each of the three clocks, External Clock, External

Clock 2, and Multiplexer Clock, is controlled by a menu item. The two

External Clock inputs are OR'd together within the Omni, and they act

internally as a single clock which simultaneously samples all 32

channels.

The External Clock input line is on Probe L

Enter 1 in this item to select the rising edge of the clock pulse
as the active edge, or 0 to select the falling edge. While the 16

Channel Mode allows you to enter X to make the External Clock inactive,
in the 32 Channel Mode this item will not accept an X. If Probe l is

disconnected, the External Clock is automatically made inactive. To

make it inactive with the probe connected, enter a l and leave the probe
lead floating (high).

Item C) Ext Clock 2

External Clock 2 is a second external clock input line. It is on

Probe 3. The comments above about Item B apply to this item as well.

Item D) Mux Clock

The Multiplexer Clock function is used to demultiplex internally
signals taken from a multiplexed source. The Multiplexer Clock signal
is picked up by the clock input line on Probe 4.
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When the multiplexer function is active, the 8 data bits sensed by
Channels DF-DS (Probe 2) are sampled on the active edge of the

Multiplexer Clock signal, and transferred to a latch. The next external
clock signal (from External Clock or External Clock 2) will cause the
data to be collected from the latch into Channels A7—A0 (normally
collected by Probe 3).

Enter 1 in this item to select the rising edge of the clock signal
as the active edge, 0 for the falling edge. Enter X to deactivate the

Multiplexer Clock function altogether. X is the default entry.

This function is very useful for collecting data from systems which
use a multiplexed data bus, such as the 8085 microprocessor. An example
of such an application appears at the end of this section.

Item F) Complex Trigger

The Complex Trigger function provides multilevel (sequential)
triggering capability. This item is used to activate the Z Menu, which
controls it. Merely accessing this item toggles the entry from No to

Yes, or vice-versa.

29.5 OPTIONS MENU

The Options Menu has been modified to accomodate the extra sixteen
channels. In particular, Items 1 and 2 allow separate specification of
the number base in which data is displayed for each of the two banks.

Item 1) Bank 0 (Dx) signals

This item specifies the number base in which the data collected on

Channels DF-DO will be displayed in the Dump Display and other displays
that show the data in numeric form. The default choice is hexadecimal.
Enter B for binary, D for decimal, U for unsigned decimal, or 0 for
octal.

Item 2) Bank 1 (Ax) signals

Item 2 specifies the number base for Channels AF—AO, similarly to

Item 1 for Channels DF-DO.

Item 3) Probe bank used for waveforms

The Waveform Display only shows sixteen channels at a time. Use

this item to select which bank will be displayed, the D(x) bank or the

A(x) bank. Accessing Item 3 toggles the selection from D(x) to A(x), or

vice—versa. Choice of the bank displayed is independent of the bank

containing the trigger word; you can trigger on the bank you are not

viewing.

29.6 DUMP DISPLAY

Operation of the Dump Display is the same as with the standard

version, except that a full 32 bit word is collected and displayed.

Omni Operating Manual 29—6 32 Channel Adapter



r!
u

Exhibit 29-4. Format of display when Instruction Disassembly is used
with the 32 Channel Adapter.

This is revealed by the fact that eight hexadecimal digits are

highlighted by the cursor, representing the 32 bit word.

29.7 INSTRUCTION DISASSEMBLY

Instruction Disassembly functions the same as in the standard

version, except that it is now possible to View 16 channels of address
in addition to the 8 channels of data and the control lines. Use

Channels AF—AO for up to 16 address lines, and Channels DF-DS for the 8
data lines. Two or three of the channels in the remaining group, D7—DO,
should be used for the control signals.

Refer to Section 17 of the Omni Operating Manual for details on

using the Instruction Disassembly function with various misreprocessors.
Exhibit 29—4 shows an example of the Instruction Disassembly display
provided when the 32 Channel Adapter is used. The full 16-bit address
is displayed, as well as the disassembled instructions from the address
bus.
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Appendix A. QUICK START

If you are like most of us, you will want to turn on the Omni and
make it do something right away. In this section we will walk you

through the Omni's basic functions and displays in about half an hour.
The advanced functions take about another hour.

The Omni's computer-based design makes it very easy to learn to

use. By the time you are done, you will know most of what you need to

know to use the Omni effectively.

I. BASIC FUNCTIONS

A.1 GETTING SET g1

Place the Omni flat on your table. Unfasten the clamps on the

right and left sides that hold on the front cover/keyboard, and pull it

off. Connect the telephone-type coil cord between the keyboard (rear
edge) and the main unit rear panel (near the top). If the rear panel
has more than one telephone-type connector, use the one marked
"KEYBOARD.” Lift the main unit and lower the stand on the underside so

that the screen is up and easily visible. Plug the connectors for the

probes into the two ribbon-cable connectors below Drive B.

Open the doors of both floppy disk drives. Some types of drives
use a pushbutton or lever to latch in the disk rather than a door.

Whichever type you have, unlatch the mechanism and remove the shipping
cards from inside the drives. Due to the nature of CP/M, turning on the
machine with a disk in the drive may result in scrambling the data on

the disk - which is why backup disks are a good practice. (Also, you
must always remember to take the disks out of the drives before turning
off the Omni).

The power switch is a large rocker switch on the rear panel. Turn

it on now. The disk drives will start whirring and you will soon see:

* Omni *

Please insert your diskette into Drive A

on the screen.

Put the logic analyzer program disk, the one labeled "Omni Logic
Analyzer Operating Disk”, in Drive A. It is all right to put a disk in
the Omni while the drive is whirring and the red light on the drive is
on. (This is not true for all computers). To put the disk in the right
way, insert it with the exposed slot to the rear and the label up. Push
it in until it clicks in place, then close the door (or actuate the

pushbutton or lever). Be careful to avoid bending the disk or touching
the brown magnetic surface in the slot, of course.

Omni Operating Manual A—l Quick Start



A.2 MASTER MENU

When you close the door of the drive, the computer will load the

CP/M operating system and display the Master Menu. The Master Menu is a

new feature that makes the system very easy to use. It displays
information about each menu choice automatically.

The Master Menu lists the major disk functions in the left column.

For the Logic Analyzer disk, the two major functions listed are:

Logic Analyzer
Disk Utilities

To select a function, use the up-arrow and down-arrow keys to move the

darkened area to the function in which you are interested. The text in

the right column describes the function marked by the darkened area.

For this example, move the dark area over "Logic Analyzer". Now

press the right—arrow key. A sub-menu giving a complete list of the

individual functions available will be displayed in the middle column:

Logic Analyzer
EPROM Programmer
Pattern Generator

Again, you can identify the program in which you are most interested by
moving the dark area over it. As before, the right column provides
details about the marked item.

Select "Logic Analyzer" and press <RETURN>. The Omni will load and

begin running the logic analyzer program.

A.3 EARLIER MODELS

Earlier models of the Omni (1984 and prior) do not have the Master

Menu feature and use the standard CP/M disk directory user interface.

(The standard interface is also available under the Master Menu system;
merely press <ESC> to leave the menu and access it.) The logic analyzer
functions are the same whether your system has Master Menu or not. If

you have the Master Menu feature, skip this section and go to section

A.4.

When you close the door of the drive, the computer will load the

CP/M operating system from the disk, and respond with the standard

prompt:

A0)

Before going further, after the "A0>" prompt type "DIR<RETURN>".

Note: here "<RETURN>" means "press the RETURN key,"
not type the characters "< R E T U R N >".

The directory listing will show at least six files. LA.COM and LA.LAO

are the logic analyzer program. LA.LAH contains the Omni's on—line Help
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information. DATA-1-.LAD, DATA-2-.LAD, and DATA-S-.LAS contain sample
data for this start—up exercise.

When the "A0>" prompt appears again after the directory listing,
type "LA<RETURN>". The Omni will load and begin running the logic
analyzer program.

A.4 LOGIC ANALYZER PROGRAM

The first part of the logic analyzer program is a self-test

sequence. If you have the probes plugged in and connected to nothing,
or if there are no probes plugged in, the tests will all be passed and

the computer will display

CLOCK CIRCUITRY TEST

TRIGGER CONTROL TEST

DATA RAM LOW LEVEL TEST

DATA RAM HIGH LEVEL TEST

GLITCH RAM LOW LEVEL TEST

GLITCH RAM HIGH LEVEL TEST

and then go on.

If the probes are plugged in and connected to something, one or

more tests will probably fail because the tests assume an ”inputs
floating" condition. If any test fails, the program will report it and

then stop. If necessary, press <SPACE> to override the stop-on-fail and

make it go on.

As part of the self-test, the program senses whether inverting or

non-inverting probes are connected. The standard Omni probes are

inverting type; when no probes are connected, the program interprets
that as the non-inverting case. If you plug in the probes after self-

test, you must go to the Options Menu and change the Probe Type to

Inverting in order to have the data displayed with correct polarity.

A.5 TRIGGER MENU

The first thing that appears after the self-test is the Trigger
Setup Menu, which controls the data collection conditions. For example,

3) Trigger Event X X X X X X X X X X X X X X X X

is the trigger word. Each "X" means "don’t care" - trigger with the bit

in that position either 0 or 1. An "X" in every position means "trigger
on anything."

We will come back to the Trigger Menu shortly. But first, press
<SPACE> to access a summary of the available commands. The first page
of this listing shows the commands which take parameters, including
those which control the Omni’s complement of useful displays.

Press any key to access the second page of commands, which lists

all the single-stroke commands at your disposal. You can get the

command list back on the screen again with the command "?<RETURN>"

Omni Operating Manual A—3 Quick Start



anytime the following command prompt line is displayed:

Enter: C,D,E,F,G,H, I,L,M,N,0,P, s,T,w,x,z,=,? ,(sp) .“P

The commands are also listed on the Reference Card following this

section, as well as on the keyboard (in abbreviated form). Operation is

simple enough, however, that reference to any separate information is

unnecessary once you gain a basic familiarity with the machine.

Press <SPACE> to return to the Trigger Menu. Look at Item 1,
Active Probes. It has two functions. First, it serves as a logic probe
to show the instantaneous logic levels on the input probe lines.

Second, it defines the channels that will be included in the Omni's data

displays.

The logic probe feature is especially useful because it shows you
which lines have activity on them before you try to perform a data

collection. Connect the ground clip on one of the probes to a data line

and watch the display change.

Practice changing the sampling conditions on the menu. Type "3" to

put the cursor on Item 3. Use the left and right arrow keys at the top
of the keyboard to move the cursor from bit to bit. Or, press "7" to

move the cursor directly to bit 7. Enter a "0" or a "l" in each bit

position to specify the trigger word. Use an "X" for "don't care".

Press <SPACE> to leave the trigger word.

Ordinarily, after setting up the trigger conditions you would type
"G" (for "Go collect data") to tell the machine to collect data, but

don't do it now. The trace memory would fill up with all 1's, since the

probes "float high" to a 1 level when they are not connected. So

instead press <SPACE> once or twice to bring up the Waveform Display.

A.6 WAVEFORM DISPLAY

The Waveform Display has sixteen traces, one for each of the probe
data lines. They are labeled DF through D0 on the left.

Probably all you will see at this point are flat traces. Near the

bottom of the screen is a window that looks like:

E:-:su

The bright area shows where the displayed samples are located in the

1000 samples of data collected. Press the "<" key (or comma, no shift

is required). The display will page to the left and you will see some

waveforms - actually, meaningless data left in memory from the turn—on

sequence. Also observe that the bright area in the window has moved

left.

The Waveform Display shows about 80 words out of the Omni’s 1000-

odd sample memory. The "<" and ">" keys (really, the comma and period)
on the keyboard just above the space bar move the display left and

right. Try it and see.
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A.7 FILES

We also have some sample data stored on disk that you can view.

One of the features that makes the Omni unique in the field of

digital analysis is its ability to store sample data and all associated

parameters on disk files. Such files appear in the CP/M disk directory
with the extension ".LAD".

The LA disk contains a sample file of previously captured data

called DATA—1-.LAD. To call it up, type "F" to access the File Menu.

Type "4" to access the choice "READ into SAMPLE memory from file". Type
"DATA—1-<RETURN>" (do not type ".LAD"; the extension is appended
automatically) and the program will load the data.

Now press <SPACE> and notice that the data which was previously on

the screen has been replaced by new data.

Study the Waveform Display further; this is a timing display, and

it contains a wealth of information. Below the traces is a scale

showing the number of each sample in the memory relative to the trigger
word. Sample 0 is the trigger word, sample 10 is the tenth after the

trigger word, sample -10 is the tenth sample before, and so on.

Below the sample scale is the hex equivalent of each sample word,
in the form of four characters in a vertical column.

The highlighted cursor may be moved right or left using the arrow

keys at the upper right on the keyboard. Try it. The number and time

of the sample marked by the cursor also appear at lower right after

cur: .

Note the prompt line at the bottom of the Waveform Display:

Enter: C,D,E,F,G,H,I,L,M,N,O,P,S,T,W,X,Z,=,?,(sp),‘P

This lists the commands that are available. All of the Omni's menus and

displays show the available choices at the bottom of the screen. A

label on the keyboard also lists these commands.

To call up Help information on the Waveform Display, type "?W" or

its lowercase equivalent, "/w".

A.8 BUM? DISPLAY

Next we'll look at a Dump Display of the same data. The Dump
Display is the other display most often used along with the Waveform

Display. Note which sample the highlighted cursor is on. Type
"D<RETURN>" for "Dump".

What you are now seeing is a hex listing of the same data, with the

same sample highlighted as before. Use the four cursor keys (top row on

the keyboard) to move the cursor around on the screen. As before, the
cursor counter "cur:" at the lower right corner gives the number of the

marked sample.
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A.9 OPTIONS MENU

The number base for the Dump Display is controlled by the Options
Menu. Let's change the base and see the same data in binary. Type "O"

(the letter "0", not zero) to display the Options Menu. Type "1" to

select Item 1 on the menu, Output Number Base.

As soon as you type the "l", the choices available are shown at the

bottom of the screen - binary (B), decimal (D), hexadecimal (H), octal

(O), and unsigned decimal (U). All the Omni's commands work this way;
as soon as you enter the first character, the Omni shows you the format

so you can enter the rest of the command correctly. No more hit-or-miss

struggling to remember command formats.

Type "B" to change the number base to binary. Now press <SPACE> to

return to the Dump Display. Now the same data is displayed in binary.

Before going on, change the base back to hexadecimal. Type "0" to

return to the Options Menu again, enter "H" in Item 1, and then press
<SPACE> to return to the Dump Display.

The system is designed so that <SPACE> usually takes you to the

next page you will need. After viewing a display, <SPACE> takes you to

the Trigger Menu so you can change the trigger conditions in preparation
for collecting a new sample. Command G then collects the new sample,
and displays it in whatever format you used last. If you lose your

place, typing <SPACE> once or twice will bring you either the Trigger
Menu or an "Enterz" command prompt line. Command T takes you right to

the Trigger Menu.

The Omni’s flexible data collection —

any trigger word or external

trigger signal, internal or external clock with trigger and clock

qualifiers - coupled with its ability to display the data in many
different ways, expands exponentially your ability to collect and

interpret meaningful digital data.

A.10 EDGE DISPLAY

Type "E<RETURN>" for Edge Display. Another form of the Waveform

Display, the Edge Display emphasizes waveform edges by omitting
sequences of 3 or more identical samples. Page the display left and

right and note that the long sequences of flat traces you saw in the

Waveform Display have been dropped and replaced by vertical rows of

blanks. In this case, the Edge Display contains about as much

information as three pages of the Waveform Display.

A.ll NAME COMMAND

One of the Omni’s most helpful features is the N Command for

renaming channels. To rename Channel Zero (the lowest trace), type:

NOTEST<RETURN>

which means “name Channel Zero TEST". You will see the label of the

lowest trace change to "TEST".
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Note that you cannot enter spaces in a label; the space bar is used
only to exit the current display. Use underscore characters in place of
spaces.

The new channel name automatically carries through to all menus and
displays. Press <SPACE> to get back to the Trigger Menu. Type "1" to

get on Item 1, then use the cursor key -> repeatedly to step the
blinking prompt-cursor along through the channels. The name of
whichever channel the prompt—cursor is on will appear at the upper right
under "Signal". When you reach channel 0, the name you assigned,
"TEST", appears. This feature relieves you of the tedious chore of
keeping track of which channel is which, and is one of the benefits of
coupling a logic analyzer with a computer.

Press <SPACE> once or twice to leave the Trigger Menu and return to
the Edge Display. Note that the program pauses and flashes a "No data
has yet been collected" message at the bottom of the screen. This is to
warn you that no new data has been collected since you changed a

parameter.

A.12 HELP PAGES

Help information is available on—line with a few keystrokes. For
example, when viewing a menu, you can call up an explanation of any item
by typing "2" followed by the item number. Try it with the Trigger
Menu. Type "T" and see the Trigger Menu again. Type "?2" and read an

explanation of Item 2, Active Glitch. Press <SPACE> to return to the
menu itself, ready to make any changes you want.

Help information is also available on the display commands whenever
the cursor—prompt is in the lower left corner of the screen. To get an

explanation of any command x, enter "?x". For example, type "?D" to see

the Help Pages for the Dump Display and Command. Now go to the Trigger
Menu and read the Help Page for each item (1, 2, ... E).

You can print out a complete listing of all the Help Pages on a

printer if you wish. Use the command "CTRL-P?" to get the printout.
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